Morningstar Direct
User’s Guide

Welcome to Morningstar Direct. This user guide will show you how to access and utilize the wealth of information available from Morningstar Direct.

This is an Internet-based database that may be accessed by using one of the public-access computers in the McLeod Business Library or the Acuff Financial Markets Center in Alan B. Miller Hall. This database is not available through remote access.

Introduction

Morningstar Direct is a web-based research platform that connects institutional investment professionals directly to Morningstar’s full universe of investment research and data (including current and historical). The program equips the patron with highly customizable tools for selecting, developing, and monitoring investments.
# Table of Contents

Introduction......................................................................................................................... 1

Table of Contents ................................................................................................................ 2

The Opening Screen/Log In ................................................................................................. 3

Home Page .......................................................................................................................... 4

Searching in Morningstar ..................................................................................................... 5
  Header Search Function .................................................................................................. 5
  New Menu Search Selections .......................................................................................... 6
    Basic Search ............................................................................................................. 6
  Advanced Search ....................................................................................................... 8

Company Page .................................................................................................................... 10

Menu Bar ....................................................................................................................... 10
  Quicktakes Menu Column ......................................................................................... 12

Header Menu Bar ............................................................................................................. 17
  File ............................................................................................................................... 17
  New .............................................................................................................................. 17
  Favorites ..................................................................................................................... 38
  Tools ............................................................................................................................ 39
  Help ............................................................................................................................. 47
  Price Monitor ............................................................................................................. 48

Menu Column .................................................................................................................. 50
  Home ........................................................................................................................... 50
    Excel API/Using the Excel Add-in ........................................................................... 53
    Training/Certification .............................................................................................. 55
  Research Reports ....................................................................................................... 57
  Local Databases ........................................................................................................ 57
  Global Databases ....................................................................................................... 63
  Performance Attribution ............................................................................................ 64
  Performance Reporting .............................................................................................. 76
  Asset Allocation ......................................................................................................... 84
  Portfolio Management ............................................................................................... 87
  Portfolio Analysis ....................................................................................................... 99
  Asset Flows ................................................................................................................ 101
  Presentation Studio ..................................................................................................... 107
    Morningstar Presentation Studio Window ............................................................. 118
  Workspace ................................................................................................................... 128
  Window Index ............................................................................................................ 149
The Opening Screen/Log In

When the Morningstar Direct program is first selected a Log In page will be displayed. The user ID is an e-mail address and should already be entered into the E-Mail Address data field.

The password must be entered each time the program is used. The computers in the McLeod Business Library have the current passwords available at each workstation. The passwords are case sensitive.

If you need assistance with the user ID or the password please contact a member of the Business Library staff.

Once you have the user ID and password entered into the data fields, click on the Log In button to open the program.
Home Page

The Morningstar Direct Home page is displayed when the program first opens. This page includes a header with a menu bar (see page 17) and search function (see page 5), a menu column (see page 50) on the left side of the page and the display area. All data is presented in the display area.

The menu column and the menu bar in the header provide alternate methods to access the information available in this database.
Searching in Morningstar

The Morningstar Direct program has several options you may use to search for data and information in the database. The search function in the header menu bar (the Search For data box) allows you to make a simple search.

The New selection in the header menu bar has a variety of selections. Each of the selections will open a new window for you to enter criteria to set up a filtering operation for the information you want. The last two selections (Basic Search and Advanced Search) have selections in their sub-menuses for locating funds and other instruments. See page 17 for information about the New menu selection.

Header Search Function

The search function in the program header enables you to conduct a simple search for securities.

To make a search, enter a search term into the Search For data box. The In Securities box has a drop down menu with only one selection, In Securities, in the Home menu column selection. Other menu column selections may have additional selections pertinent to the menu (e.g., In This View).

As you type your search term into the data box a menu of suggested terms is displayed below the data box. This list changes as you add more characters.

You may select one of the suggested terms or continue typing. If your term ends up with no suggested terms list you may click on the Go button to display the Find Investments window. This window may be used to modify your term and conduct another search. For information about using the Find Investments window please go to page 19.

The Go button will also display (in the Find Investments window) the selections available in the suggested terms list if clicked on with a list displayed.

Selecting an item from the lists, either the suggested terms list or the results list in the Find Investments window, will open the information about that entity in a new window. See page 10 for information about the Company page.
New Menu Search Selections

The New menu selection in the program header has 14 selections in its drop-down menu. These are Investment List, Reports (with seven items in a sub-menu), Alert (with three items in a sub-menu), Charts (with 16 items in a sub-menu), Account, Account Group, Model Portfolio, Strategy, Performance Report, Performance Attribution (with four items in a sub-menu), Data Set, Note, Basic Search (with seven items in a sub-menu), and Advanced Search (with 24 items in a sub-menu).

Clicking on a selection will open a search function in a new window. There are about ten different styles of search functions used. Each one is tailored to the menu selection. Some will also open a related menu column selection.

For instance the Investment List selection will open a Select Investment window as well as the Investment Lists sub-menu selection under the Workspace menu column topic.

Please refer to page 17 for information about the New menu selections other than Basic Search (which is presented below) and Advanced Search (see page 8).

Basic Search

The Basic Search menu selection has a sub-menu with seven selections. These are Open-End Fund, Pension/Life/Insurance (with two selections in another menu), Closed-End Fund, Exchange Traded Fund, Separate Accounts/CITs, Hedge Fund, and Unit Investment Trust.

Each of these selections (and the sub-menu items) will open a Morningstar Direct window. All are similar in appearance and operation. The individual windows identify the selection in the title bar.

Each search function will provide a search tailored to the menu selection.

The basic search function window has four buttons (Open, Clear All, Save As and Feedback) across the top of the window and search criteria grouped into three sections (Basic, Performance, and Portfolio).
The **Open** and **Save As** buttons open similar windows where any existing searches are listed. The **Save As** window allows you to name and save your current search.

The **Open From** window allows you to select an existing search (if any have been saved). To select a search highlight the one you want and click on the **OK** button.

Please note that the searches are particular to the menu selection in which you are currently working. For instance, a search saved in the in the **Open-End Funds** menu selection will not be displayed in any other search function.

The **Clear All** button will clear all selections you may have made and return the search criteria to their initial status.

The **Feedback** button allows you to send comments to the Morningstar company.

The search criteria are displayed in the main section of the window. The Basic section is open when the window is first displayed. The other sections may be opened (or closed) by clicking on the arrow by each section name.

Each section has criteria that may be selected. You may select as many (or as few) criteria as you need.

Once you have made your selections click on the **Run Search** button at the bottom of the screen. The results of your search will be indicated by a number under the **Items Found** heading. If the number is very large you may add criteria and run the search again.

After obtaining a number you feel you can work with click on the **OK** button.

This will open a results page under the **Workspace** menu column topic **Search Criteria** selection. See page 135 for information about using the search results table.
Advanced Search

The Advanced Search menu selection has a sub-menu with 24 selections. These are All Managed Investments, Analysis/News/Report (with four selections in another menu), Bonds, Category Average (with three selections in another menu), Closed-End Fund, College Savings Plans (with two selections in another menu), Economic Series, Exchange Traded Fund, European Pension/Life Fund Wrappers, Hedge Fund, HFR Hedge Funds, Institutions, Market Index, Money Market Fund, Open-End Fund, Ownership-Portfolio, Ownership-Security, Pension/Life/Insurance (with six selections in another menu), People, Private Funds, Restricted Investors, Separate Accounts/CITs, Stock, and Unit Investment Trust.

Each of these selections (and the sub-menu items) will open a Morningstar Direct window. All are similar in appearance and operation. The individual windows identify the selection in the title bar.

Each search function will provide a search tailored to the menu selection.

The advanced search function window has eight buttons (Open, Insert, Delete, Clear All, Export, PDF, Save As and Feedback) across the top of the window and a blank table for entering search criteria.

The Open, Clear All, Save As and Feedback buttons perform the same actions as those in the Basic Search. See page 7 for information about these buttons.

The Insert button allows you to insert a new line above a line that you have already set up with criteria. You select the line you want to insert a line above by clicking on the check box by the line number.

The Delete button will delete the selected (check mark in the check box) line.

Export will immediately export the table to Excel.

The PDF button will open a new window where you may name the report and save it (in the Saved Reports area of the Workspace topic) or e-mail it. It will be in PDF format when it is then opened.
Setting Up Criteria

To set up a search follow these steps:

1. In line no. 1, click on the **Click Here to Start a New Search** link in the Field Name column.

2. This will open a menu with a number of selections. You may select one item from the list. The items on the list vary depending on the style of search being made. For instance the **Closed–End Funds** menu is different from the one displayed in the **Institutions** search feature.

3. After making your selection, click on the next cell in the Operator column. You will have a list of operators that are appropriate to the item selected in the first column. Some selections will have the operator automatically filled in.

4. After selecting an operator, click on the next cell in the Value column. A list of values that are pertinent to the selected field will be displayed. Some selections will not have a list of items, you will need to enter a term into the data cell.

5. Repeat these steps for each line you wish to use. You may use as many lines as you feel necessary.

Once you have made your selections click on the **Run Search** button at the bottom of the screen. The results of your search will be indicated by a number under the Items Found heading. If the number is very large you may add criteria and run the search again.

After obtaining a number you feel you can work with click on the **OK** button.

This will open a results page under the **Workspace** menu column topic **Search Criteria** selection. See page 135 for information about using the search results table.
Company Page

Once a list of companies has been assembled, clicking on a name in the list will open the page for that company in a new window.

The Company page has a menu bar, a Quicktakes menu column and a display area.

Menu Bar

The Menu bar has selections for File, Help and Reports. There is also a search function (Search For data box) that operates in the same manner as the header search function on the Morningstar Home page. See page 5 for information about this search function. The results of this search will be opened in another new window.

The Send Us Feedback link will open a window with an e-mail form ready to fill in. This is used to let the company know if there is a problem with any of the functions of the Morningstar Direct program.

File

The File menu selection has only one selection under it: Exit. Click on this to close the Company page window.

Help

The Help menu selection has three selections: Contents/Index, Contact Us, and Subscription Agreement.

The Contents/Index selection will open a window with a standard Windows-type help feature. You may search for topics for help.

The opening page has links to a guide and information sheets in PDF format. These include Quick Start Guide; Coverage, Reports, and Presentations; Samples; and Technical Specifications Guide.

Each of these will be opened in the display area of the help window. The Quick Start Guide is a PDF document with more than 250 pages.

The Contact Us and Subscription Agreement menu selections open windows with information pertinent to the topic.
Reports

The Reports menu selection has a menu with two items: Investment Detail Report and Quicktake.

The Investment Detail Report selection will open a new window with a report in PDF format. You may name and Save this report or E-mail it by using the Report Title box and the buttons across the top of the window. Reports are saved to the Saved Reports selection under the Workspace topic in the Morningstar Menu Column in the main Morningstar screen (see page 145). You also have the option to print the report using the Adobe Reader controls in the display area.

The Quicktake selection will open a window with some selections that allow you to create a report on specific areas. You may select Cover Page, All Standard Pages, Snapshot, Analysis, Financials, Valuation/Estimates, Ownership, All Appendix Pages, Annotated Snapshot or All Pages.

The Snapshot selection is already selected when the window opens. This will give you a one-page tear sheet of information about the company.

The All Standard Pages selection will include the five selections below it and will give you a six page report.

When you have made your selections click on the OK button. This will open the report in a new window similar to the one for the Investment Detail Report above. You may save, e-mail or print the report from this window.
Quicktakes Menu Column

The Quicktakes menu column allows you to access the various types of information available in the Company page. The selections are grouped into 15 topics: Snapshot, Company Profile, Industry Peers, News, Analysis, Performance, Insider, Financials, Valuation/Estimates, Key Ratios, Transcripts, Ownership, Charts, Reports, and Notes.

Snapshot

The Company page opens with the Snapshot selection displayed. The Snapshot page displays a variety of general information and data about the company.

The PDF Report link at the top of the page will open the same window as the Quicktake selection under Report in the Company page header menu bar. Please go to page 11 for information about this feature that will give you a report in PDF format.

The Print This Page link will send the page to the printer of your choice.

Company Profile

The Company Profile selection will display a short description of the company, its industry classification, and operations. The PDF Report and Print This Page links perform the same actions as the same links in the Snapshot page.

Industry Peers

The Industry Peers selection displays a table of information about the company and members of its peer group. The PDF Report and Print This Page links perform the same actions as the same links in the Snapshot page.
News

The **News** selection will display a page with a long list of articles and reports about the company. The list includes the source, date and title of the items. Clicking on a title will open the full text article in a new window.

Analysis

The **Analysis** topic has three selections: **Analysis**, **Historical Analysis**, and **Bonds**.

Each of these selections will display a page with different aspects of analysis information about the company.

The **Bonds** selection will display a page of charts and graphs.

Performance

The **Performance** topic has three selections: **Total Returns**, **Price History** and **Dividends & Splits**.

Each of these selections will display a page with information about the stock performance. The **Dividends & Splits** page lists a five-year dividend history.
Insider

The Insider topic has five selections: Executive Compensation, Insider Activity, Key Executives, Board of Directors, and Committees.

The Executive Compensation selection opens a display with a variety of information about the compensation for the company’s top executives. The top part gives total compensation while individual compensation is presented in the lower portion of the screen. Hovering the mouse pointer over the chart will also display a small window with individual executive compensation.

Selecting Insider Activity will display a page with a chart of Weekly Insider Activity. The lower section of the page will have a table of individual transactions.

The Key Executives and Board of Directors selections will open pages with a table of members of those categories. Each entry includes the person’s name, age, position, year joined the company, and a lead-in of their biography.

Clicking on a cell will open a page for that person. This page will include the name, position, compensation, brief bio, and other information. The information available for each person varies, some may not have all topic areas.

The Committees selection will open a page with various committees listed. The membership of each committee is included under the committee name.

Financials

The Financials topic has three selections: Income Statement, Cash Flows, and Balance Sheet.

Each of these selections will open a page with financial information about the company. All of these pages include ten years of data.
Valuation/Estimates

The Valuation/Estimates topic has three selections: Valuation Ratios, Earnings Estimates, and Analyst Opinions.

These three selections each will open a one-page display of data related to the topic. These pages give information on the company compared to the industry and other standards, estimates of how the stock will perform and analysts’ opinions concerning the stock.

Key Ratios

The Key Ratios selection will open a page with several tables of financial data. The lower table will have key ratios.

Ownership

The Ownership topic has five selections: Shareholders Overview, Major Shareholders, Concentrated Shareholders, Shareholders Buying, and Shareholders Selling.

These selections will display information about shareholders who own the company’s stock. Each page will display information pertinent to that selection.

The Major Shareholders page is pictured.

The Concentrated Shareholders selection will display a list of the funds holding the largest concentration of company stocks, as a percentage of the fund’s total assets.

Charts

The Charts topic has four selections: Price, Fundamental, Technical, and Fair Value.

Each of these selections will open a page with an interactive chart. All the pages have three icons that allow you to Print the chart, Copy the chart (so it can be pasted into another program) or Reset any changes you may have made to the original display.
Each chart displays data when the mouse pointer is hovered over the chart. For instance, in the Fair Value chart pictured the pointer is over the intersection of the vertical and horizontal lines. The annotated figures near the top of the chart indicate the fair value and the close price for that date. These figures change as the pointer is moved over various parts of the chart.

The **Price** chart allows you to select the time period to be displayed. The **Time Period** data box drop-down menu has eleven periods from which to choose, from one day to ten years, as well as **Custom** and **Maximum**. The **Custom** selection causes two more data fields to be displayed that allow you to select **Start** and **End** dates. The **Maximum** selection will display about thirty years of data, depending on the company being researched.

The heading also has selections that allow you to choose between Linear or Logarithmic charts; High, Low and Close or Line charts; and to display Splits and/or Total Return.

The **Fair Value** chart is similar to the **Price** chart but only has the **Time Period** data box with seven selections.

The **Fundamental** chart has a menu bar with the menu selections: **Financial** (with eight selections), **Multiples** (with four selections), and **Annual Growth** (with four selections). Each selection in the drop-down menus will display a new chart.

The page first opens with the Earnings/Share chart displayed (which is the **EPS** selection under **Financial**).

The **Technical** chart has the **Time Period** data box and some selections similar to the **Price** chart. The menu bar also has three selections: **Indicators** (with three selections), **Moving Avg.** (with two selections), and **Price Overlays** (with three selections). Most of these have sub-menus for more selections. Each will display a new element for the basic chart.

**Reports**

The **Reports** selection will open a page with any company reports that may have been saved. Any reports on the list may be **Deleted** (in the **Action** menu), **Exported** (the report will be sent directly to Excel), or **Printed**.

**Notes**

The **Notes** selection will open a page with any locally generated company notes that may have been saved. Any notes on the list may be **Deleted** (in the **Action** menu), **Exported** (the report will be sent directly to Excel), or **Printed**.
Header Menu Bar—File and New

The Header Menu Bar has five selections with drop-down menus (File, New, Favorites, Tools, and Help), a Price Monitor selection, a search function (see page 5), and a link to send feedback to the Morningstar company. The Send Us Feedback link will open a window with an e-mail form ready to fill in. This is used to let the company know if there is a problem with any of the functions of the Morningstar Direct program.

File

The File selection has a drop-down menu with three items. These are Set User Preferences, New Folder, and Exit.

The Set User Preferences selection opens a window with a number of options that may be set or changed. The program is already set up for optimum performance, please do not try to adjust any of the settings.

New Folder will open the New Folder window. This allows you to create a new folder under the Workspace topic in the Morningstar Direct menu column. You are limited to the areas listed in the New Folder window.

To create a folder highlight the folder in which you wish to insert your new folder.

Enter a name into the Name box and click on the OK button. The new folder will be added to the area you selected.

The new folder may be deleted by right clicking on the folder and selecting Delete from the content menu.

Clicking on the Exit selection in the File menu will immediately close the program, without asking if that is what you really want to do.

New

The New menu selection in the program header has 14 selections in its drop-down menu. These are Investment List, Reports (with seven items in a sub-menu), Alert (with three items in a sub-menu), Charts (with 16 items in a sub-menu), Account, Account Group, Model Portfolio, Strategy, Performance Report, Performance Attribution (with four items in a sub-menu), Data Set, Note, Basic Search (with seven items in a sub-menu), and Advanced Search (with 24 items in a sub-menu).

Clicking on a selection will open a search function in a new window. There are about ten different styles of search functions used. Each one is tailored to the menu selection. Some will also open a related selection in the menu column.

For instance the Investment List selection will open a Select Investments window as well as the Investment Lists sub-menu selection under the Workspace menu column topic.
Please refer to page 6 for information about the Basic Search and Advanced Search menu selections. The other selections are presented below.

Investment Lists

The Investment Lists selection will open the Select Investments window. The Investment Lists selection under the Workspace topic in the menu column also becomes active.

The Select Investments window allows you to choose from five methods the one you want to use to select investments.

Your choices are: Single Investment, Multiple Investments, Search Criteria, My Lists, and Import List. You may only use one of these at a time.

The Single Investment selection is associated with the box beside it. You may enter a name, ticker, ISIN, CUSIP or SecId into the box. As you enter data a list of suggested items is displayed. Clicking on an item will place that company into a new list in the My Lists selection under Investment Lists in the Workspace topic.

This list is in a table format with more than 50 columns. Double clicking on a company name will open the Company page (see page 10) for that company. For information about the My Lists feature please go to page 128.
The **Multiple Investments** selection does not have an associated box. You use this selection by selecting it and then click on the **OK** button.

This will open the **Find Investments** window. This window is used to create a list of multiple items before sending the list to the **My Lists** feature.

Begin by selecting where you want to search (**Universes**, **My Lists**, or **My Searches**).

The **Universes** selection uses the box below it. This box has a drop-down menu with many selections.

After making your selection from this menu go to the **Find By** box and make a selection from that drop-down menu to tell the search feature what you are looking for (i.e., **Name**, **Legal Name**, **Ticker**, **SecId**, **CUSIP**, **ISIN**, or **APIR Code**). You also may choose the search to find only those items where the item **Begins With** the search term or **Contains** it. The **Include Only Surviving Investments** selection will narrow the search to only those items.

Finally, enter your search term into the box by the **Go** button.

The procedure for using the **My Lists** and **My Searches** selections are similar to the **Universes** selection:

After selecting **My Lists** or **My Searches** the box’s menu below it changes to list all saved lists or searches. Make your selection and enter your search term into the box next to the **Go** button. The **Find By** menu only has one selection: **Name**.

After making your selections and entering your data click on the **Go** button.

Any items found in your search will be displayed in the Available Records section of the **Find Investments** window.

You select the items you want to add to your list by highlighting them and clicking on the **Add** button. All items on the list may be selected by clicking on the **Add All** button.

If there are many items you may jump to a specific one by starting to type a name into the **Jump to Record Name** box. The list will scroll as you type.
You may repeat the search process as many times as you need to find all the items you want. Each time a search is made and an item is added, it is placed into the Selected Records section of the Find Investments window.

Once you have a list of items in the Selected Records section you may adjust the list by moving items up or down in order on the list (highlight it and click on the up or down arrows) or you may remove an item by highlighting it and clicking on the Remove button. All items may be removed by clicking on the Remove All button.

Once you have manipulated the list into the order you want, click on the OK button to have the list placed into the My Lists selection of Investment Lists under the Workspace topic. See page 128 for information about the My Lists feature.

The Search Criteria selection of the Select Investments window will activate the Stocks box next to it. Select the item you want to use by highlighting it and then click on the OK button. This will open a Morningstar Direct window tailored to your selection.

This window is similar to and operates in a similar manner as the Advanced Search function window. Please go to page 8 for information about how to use this feature.

This instance of the advanced search window will open a list in the My Lists selection of the Workspace topic.

The My Lists selection of the Select Investments window will activate the box next to it. This box has a drop-down menu with numerous selections. Select the item you want to use by highlighting it and then click on the OK button. This will open a list in the My Lists selection of Investment Lists under the Workspace topic. See page 128 for information about the My Lists feature.
The last selection is **Import List**. To use this selection you must have a list of your own ticker symbols (in a single column in text or Excel format) available.

Make your selection by clicking on the radio button and click on the **OK** button. This will open the **Import List** window.

The **Import List** window prompts you to enter your file name or browse to the location (e.g., USB Flash Drive) of your file; select the type of file (**Text** or **Excel**); and the identifier (**CUSIP**, **ISIN**, **SEDOL**, **VALOR**, **WKN**, **Ticker**, **Oslo Bore**, **SecId**, **FundId**, or **APIR**).

Once you have made your selections click on the **OK** button. The program will import your list and display the results in the **My Lists** selection under **Investment Lists** in the **Workspace** topic of the menu column. See page 128 for information about the **My Lists** feature.

**Reports**

The **Reports** selection under the **New** menu has seven more selections in a sub-menu. These are: **Comparison: Holdings**, **Comparison: Multiple Investments**, **Comparison: Two Investments**, **HB Style Consistency**, **Investment Summary**, **Performance Evaluation**, and **RB Style Analysis**.

Each of these selections will open the **Find Investments** window.

The operation of the **Find Investments** window is the same for all these selections. Please go to page 19 for information about using this window.

Under the **Reports** selections, once you have a list assembled in the **Find Investments** window and you click on the **OK** button another new window is opened.

The new window is the **Report Settings** screen. Each **Report Settings** screen is tailored to the individual **Reports** selection. The **Holdings-Based Style Consistency** (**HB Style Consistency** selection) screen is pictured.

Each **Report Settings** screen allows you to fine tune the report you are generating. Some screens are very simple while others have many options. They all have settings for the first and last month and a list of the investments. You do not have to make any changes if you are satisfied with the default settings displayed.

After making any changes click on the **OK** button. You will be prompted to save your report. Click on the **No** button to continue on to your report. Clicking on the **Yes** button will open a window where you are prompted to name the report.
The report is opened in a standard Morningstar Direct report window. Each report typically has one page for each company originally selected. Please go to page 11 for information about the report window.

**Alert**

The **Alert** selection under the New menu has three items in its menu: **Price**, **Morningstar** and **Filing**.

Each of these will open an Alert window tailored to the specific selection.

These windows allow you to set the parameters for an alert. Most parameters are set by clicking on check boxes so that check marks appear.

There are some selections made from drop-down menus. The Price Alerts window also has some boxes where you may enter values.

The Morningstar Data Point Alerts window has numerous selections in nine sections.

*Please note that an e-mail notification will not produce an e-mail to the person setting up the alert because an e-mail address is not entered. An alert would go to the subscription e-mail address on record.*

Click on **Save** when you have finished setting up the alert. The alert is then added to the list under **Alerts** under the **Home** topic in the menu column.
Charts

The Charts selection under the New menu has 16 more selections in a submenu. These are: Correlation Matrix, Floating Bar, Growth, HB Style Map, HB Style Trail, Holdings Similarity, Price, RB Style Trail, Return Bar, Return Vs Category, Risk/Reward, Rolling Return (Bar), Rolling Return (Line), Scatterplot, Stacked Bar, and Time Series.

All the selections under Charts operate in a similar manner. There are several steps involved in creating a display.

When a selection is first opened there is one of three windows displayed: The Select Investments, Dialog, or Find Investments window. Most of the selections will open the Select Investments widow (see below). The Floating Bar, Scatterplot and Time Series selections will open the Dialog window (see page 25) and the Stacked Bar selection will open the Find Investments window (see page 19).

Select Investments Window

The Select Investments window allows you to choose from five methods the one you want to use to select investments.

Your choices are: Single Investment, Multiple Investment, Search Criteria, My Lists, and Import List. You may only use one of these at a time.

The Single Investment selection is associated with the box beside it. You may enter a name, ticker, ISIN, CUSIP or SecId into the data field. As you enter data a list of suggested items is displayed. Clicking on an item will open the chart for the category selected, the chart for Growth is pictured.

Each selection from the Charts menu will display a different chart after following the same procedure in the Select Investments window.

Once a chart window is open there are some controls in the heading that will allow you to perform a number of tasks. There are six icons: New, Clipboard, PowerPoint, Create PDF, Export Excel, and Save. The New icon will open a window with the same feature used to originally create the chart so that you may create a new chart in the same style. The Clipboard icon will copy the chart to the Windows clipboard so that it may be pasted into another program (i.e., Word). The PowerPoint icon will open the PowerPoint program with the chart already pasted into a slide. The Create PDF icon will open a Report window where you may e-mail, save or print the chart. See page 11 for information about the Report window. Export Excel will export the data to Excel. Save will save the chart to the Chart Templates list in the Workplace topic of the menu column.
The **Multiple Investments** selection does not have an associated box. You use this selection by selecting it and then click on the **OK** button.

This will open the *Find Investments* window. This window is used to create a list of multiple items before using the list to create a chart.

Begin by selecting where you want to search (**Universes**, **My Lists**, or **My Searches**).

The **Universes** selection uses the box below it. This box has a drop-down menu with many selections.

After making your selection from this box go to the **Find By** box and make a selection from that drop-down menu to tell the search feature what you are looking for (i.e., **Name**, **Legal Name**, **Ticker**, **SecId**, **CUSIP**, or **ISIN**). You also may choose the search to find only those items where the item **Begins With** the search term or **Contains** it. The **Include Only Surviving Investments** selection will narrow the search to only those items.

Finally, enter your search term into the box by the **Go** button.

The procedure for using the **My Lists** and **My Searches** selections are similar to the **Universes** selection:

After selection the box changes to display a different menu. Make your selection and enter your search term into the box next to the **Go** button. The **Find By** box menu only has one selection: **Name**.

After making your selections and entering your data click on the **Go** button.

Any items found in your search will be displayed in the Available Records section of the *Find Investments* window.

You select the items you want to add to your list by highlighting them and clicking on the **Add** button. All items on the list may be selected by clicking on the **Add All** button.

If there are many items you may jump to a specific one by starting to type a name into the **Jump to Record Name** data field. The list will scroll as you type.

You may repeat the search process as many times as you need to find all the items you want. Each time a search is made and an item is added, it is placed into the Selected Records section of the *Find Investments* window.

Once you have a list of items in the Selected Records section you may adjust the list by moving items up or down in order on the list (highlight it and click on the up or down arrows) or you may remove an item by highlighting it and clicking on the **Remove** button. All items may be removed by clicking on the **Remove All** button.

Once you have manipulated the list into the order you want, click on the **OK** button to have a chart created using your list. The Growth chart, with multiple companies, is pictured.
The **Search Criteria** selection of the *Select Investments* window will activate the Stocks box next to it. Select the item you want to use by highlighting it and then click on the **OK** button. This will open a *Morningstar Direct* window tailored to your selection.

This window is similar to and operates in a similar manner as the Advanced Search function window. Please go to page 8 for information about how to use this feature.

This instance of the search window will open a chart window. The Growth chart is pictured.

The **My Lists** selection of the *Select Investments* window will activate the box next to it. This box has a drop-down menu with numerous selections. Select the item you want to use by highlighting it and then click on the **OK** button. This will open a chart window. The chart for the **Growth** selection is pictured.

The last selection is **Import List**. To use this selection you must have a list of your own ticker symbols (in a single column in text or Excel format) available.

Make your selection by clicking on the radio button and click on the **OK** button. This will open the **Import List** window.

The **Import List** window prompts you to enter your file name or browse to the location (i.e., USB Flash Drive) of your file; select the type of file (**Text** or **Excel**); and the identifier (**CUSIP**, **ISIN**, **SEDOL**, **VALOR**, **WKN**, **Ticker**, **Oslo Bore**, **SecId**, **FundId**, or **APIR**).

Once you have made your selections click on the **OK** button. The program will import your list and display the results in a chart window.

**Dialog Window**

The **Dialog** window allows you to choose from five methods the ones you want to use to select investments and data points.

Your choices for Investments are: **Name/Ticker/ISIN/CUSIP/SecId**, **Search Criteria**, and **My Lists**. The choices for Data Points are: **New Data Points** and **My Lists**. You choose one item from each category.

**Name/Ticker/ISIN/CUSIP/SecId**

Depending on the selections you make the path to the end chart varies. For instance, selecting **Name/Ticker/ISIN/CUSIP/SecId** and **New Data Points** will open the **Find Investments** window. You use the **Find Investments** window to
develop a list of items. See page 19 for information on using the *Find Investments* window.

Clicking on OK in the *Find Investments* window will open the *Select Data Points* window. You use this window to select the data points you want to use in your chart.

This window has a list of all data points available. You may select specific data point sets by changing the **Universe** or the selections in the **Find Data Points By** data field drop-down menu. The data points available are displayed in the Available Data Points box.

You select the data points you want by highlighting a data point (more than one may be selected at a time by holding the **Shift** or **Ctrl** key while clicking on them) and clicking on the **Add** button. This will move the selected data points to the Selected Data Points box. Once you have a list of items in the Selected Data Points box you may adjust the list by moving items up or down in order on the list (highlight it and click on the up or down arrows) or you may remove an item by highlighting it and clicking on the **Remove** button. All items may be removed by clicking on the **Remove All** button.

When you have finished selecting the data points you want click on the **OK** button. This will open the **Chart Settings** window.

The **Chart Settings** window allows you to make final adjustments to the chart settings before opening the chart. This window has three tabs: **General**, **Investment** and **Peer Group**. Although you may leave the settings in the **General** and **Investment** tabs as displayed, you have to select settings in the **Peer Group** tab before the chart will be opened.

The **General** tab lists the data points you had selected in the **Select Data Points** window. There are also four settings you may change in the Floating Bar Settings section.

The **Investment** tab lists the companies you had selected in the **Find Investments** window. This tab also has some settings you may change.

The **Peer Group** tab has selections for **Universe** (which include another selection for **Category**) and **My Lists**. Each of these items has a data field with a drop-down menu from which to make selections. You must select a peer group in order to create a chart. In the **Universe** item you must make a selection from both the **Universe** and **Category** menus.

When finished, click on the **OK** button.
That will open the chart window with the chart displaying the results of your selections.

Note, using the **Name** selection with the **My Lists** selection (data points section) in the **Dialog** window will produce the same sequence of steps except the **Select Data Points** window is not used, you will go directly to the **Chart Settings** window from the **Find Investments** window.

**Search Criteria**

Selecting **Search Criteria** (you may select the criteria from the drop-down menu next to the **Search Criteria** selection) and **New Data Points** in the **Dialog** window will open an advanced search type window. Please go to page 8 for information about how to use this feature.

After creating a list of companies in the search window the **Select Data Points** window will be opened. From this point the process is the same as that using the **Name** selection in the **Dialog** window. See page 26 for information on using the **Select Data Points** window process from this point on.

Note, using the **Search Criteria** selection with the **My Lists** selection (data points section) in the **Dialog** window will produce the same sequence of steps except the **Select Data Points** window is not used, you will go directly to the **Chart Settings** window from the advanced search window.

**My Lists**

Selecting **My Lists** (you may select the criteria from the drop-down menu next to the **My Lists** selection) and **New Data Points** in the **Dialog** window will open the **Select Data Points** window.

From this point the process is the same as that using the **Name** selection in the **Dialog** window. See page 26 for information on using the **Select Data Points** window process from this point on.

Note, using the **My Lists** selection with the **My Lists** selection (data points section) in the **Dialog** window will produce the same sequence of steps except you are taken directly to the **Chart Settings** window.
**Find Security Window**

Selecting **Stacked Bar** from the **Charts** sub-menu will open the **Find Investment** window, which is a modified version of the **Find Investments** window. See page 19 for information about using this window.

One main difference is that the **Find Investment** window has only one section, the Available Records section. After you have found a list of items you may select only one item from the list. Once you have selected an item by highlighting it click on the **OK** button to continue the process.

This will open a modified **Chart Settings** window with only two tabs: **General** and **Data**. Each of these tabs have some settings you may change to modify the final chart. After making any changes click on the **OK** button.

This will open the chart in a new window.
Account

The Account selection under the New menu will open the New Account window. This window has two selections: Account by Position and Transactional Account. (When the window opens the main Morningstar Direct screen is opened to the Accounts selection in the Portfolio Management topic of the menu column. See page 87 for information about this selection.)

Click on the radio button next to your selection and then click on the OK button.

Account by Positions

The Account by Positions selection will open the Account Basics window.

In the Account Basics window you enter a name for your account in the Name box. In the remaining boxes you may leave them with the existing entries or use the drop-down menus to select another setting.

The Benchmark 1, Benchmark 2 and Risk Free Proxy boxes have icons that will open a Select Benchmark window. This window is similar to and operates in a similar manner as the Find Investments window. See page 19 for information about the Find Investments window.

Once you have identified the item you wish to use in your account click on the OK button and it will be placed in the box in the Account Basics window.

After setting up your basic account click on the Save button in the Account Basics window. This will open the Holdings Entry window. You use this window to complete setting up your account.

Initially, all cells are empty. Click on the first cell in the Symbol column and type in a ticker symbol. As you type a list will appear. Select the company you want from the list. The row of cells will then be populated with data about the selected company.

You must add percentages in the Percent column. The total must equal 100%.

After entering your data click on the Finish button. This will add your new
account to the account list in the **Accounts** selection under the **Portfolio Management** topic of the menu column. See page 87 for information about this selection.

Double click on your account’s name to open the **Account** window.

This window has four selections: **Holdings Summary** (the opening display), **General Settings**, **Imported Price/Return** and **X-ray**.

The **Holdings Summary** selection will display a table of information about your account. The data is in ten columns.

The **General Settings** selection is similar to the **Account Basics** window and it allows you to change your account settings.

The **Imported Price/Return** display shows any data that has been imported.

The **X-ray** selection has three items under it: **Stock Sectors**, **World Regions** and **Top 10 Holdings**. Each selection will give you a broad view of the selected topic. You may display the report in PDF format by clicking on **PDF Report** in the display header. The report will be displayed in a new window. See page 11 for information about the report window.

The **Account** window is the same window that is opened when an account is selected from the list under the **Accounts** selection in the **Portfolio Management** topic of the menu column. See page 93 for information about the **Accounts** selection.

**Transactional Account**

The **Transactional Account** selection will open the **Account Profile** window. This selection is used to apply and track transactions in the account. Enter an account name into the **Name** data field and a portfolio name into the **Portfolio ID** data field.

Select the currency, performance source and performance series from the data field menus.

Click on the **Next** button. This opens the **Transaction Blotter** window for the new account. This page is used to set up transactions for the account. You may manually enter information into the data fields or click on the **Transaction Wizard**.
selection in the menu bar. This will open the wizard where you enter information for each transaction. Enter the ticker for a stock in the Security Name box. A list of suggested companies is displayed as you type. Select the one you want from the list.

In the Transaction Type box drop-down menu select the type you are creating. The Buy selection adds a new section below the initial data fields. This is pictured.

After completing this form click on the Post to Account button. You may then change the information for other transactions.

When you have finished click on the Close button. This will close the wizard. The transactions are not displayed in the Transaction Blotter window. Close the Transaction Blotter window to display the Account window for your transactional account.

This Account window is similar to the Account window used for the Account by Position selection. The Transactions selection in the menu column will open a table of transactions for the account. This display is similar to the Holdings Summary table.

The Profile/Settings selection has two items under it: Account Profile and Account Settings. These selections open pages where you may change the settings for this account.

The account will also be listed in the Account list in the Account selection in the Portfolio Management topic of the menu column. See page 93 for information about this selection.

Account Group

The Account Group selection in the New menu will open a window where you may set up a group. Enter a name in the Group Name box.

Click on the Save button when you have finished setting up the group.

The group will be listed in the Account Group list in the Account Groups selection in the Portfolio Management topic of the menu column. See page 94 for information about this selection.
Model Portfolio

The Model Portfolio selection in the New menu will open the Model Portfolio Basics window. The Model Portfolios selection in the Portfolio Management topic of the menu column is also opened. See page 88 for information about this selection.

Enter a name into the Name box and make selections in the other menus. Click on the Save button when you have finished setting up the portfolio. It will be added to the list in the Model Portfolio selection of the Portfolio Management topic.

Strategy

The Strategy selection in the New menu will open a window where you may set up a strategy. The Strategies selection in the Portfolio Management topic of the menu column is also opened. See page 87 for information about this selection.

Enter a name for the strategy in the Strategy Name box and use the selections in the window to set up your strategy. Click on the OK button when finished. The strategy will be added to the list in the Strategies selection of the Portfolio Management topic.

Performance Report

The Performance Report selection under the New menu will open a Select Investments window.

The Reports selection under the Performance Reporting topic in the menu column also becomes active. See page 76 for information about the Performance Reporting topic.

See page 18 for information about using the Select Investments window. Clicking on the OK button will open the Group Settings window. The Group Settings window allows you to adjust settings for group comparison.
Clicking on the OK button in the Group Settings window will open a Select Column window. After making any selections in this window, click on the OK button.

This will open another window (Time Period Setup) where you can make selections in Time Periods, Data Points and Ranks. After making any adjustments click on the OK button.

This will open still another window (Supplementary Data Points). This window gives you more options for making adjustments. Again, after making any changes click on the OK button.

This will display a table under Reports in the Performance Reporting topic of the menu column. See page 76 for information about the Performance Reporting topic.

Performance Attribution

The Performance Attribution selection under the New menu has a sub-menu with four selections: Equity Single Attribution, Equity Multiple Attribution, Total Portfolio Attribution, and Total Multiple Attribution. The Equity Single Attribution and Total Portfolio Attribution selections will open a New Report window. The Equity Multiple Attribution selection will open the Select Multiple Portfolios window. See page 68 for information about the Select Multiple Portfolios window.

When these selections are opened the Performance Attribution topic in the menu column is also opened. See page 64 for information about the Performance Attribution topic.

New Report Window

The New Report windows opened for the Equity Single Attribution and Total Portfolio Attribution selections are similar but have different settings available. The window for the Total Portfolio Attribution selection (pictured) has a few more data boxes in the top section.

A portfolio name is entered into the Portfolio box. If you do not know the portfolio name, you may look up a name by clicking on the icon to the right of the box. This will open the Select a Portfolio window.
The Select a Portfolio window is similar to the Find Investments window. See page 19 for information about the operation of the Find Investments window.

After selecting an item from the results box click on the OK button, this will place the selected portfolio into the Portfolio box in the New Report window.

You may change the Benchmark by selecting one from the drop-down menu. The second Benchmark data field (in the window for the Equity Single Attribution selection) must be populated before the process can continue. If you do not know a benchmark to enter, click on the icon beside the data field. This will open the Select a Policy window (which operates in a similar manner as the Select a Portfolio window—see above).

After selecting an item from the results box, click on the OK button to place the item into the Benchmark box in the New Report window.

Next select the Currency you want the report to use (in the Total Portfolio Attribution selection). You do this by selecting an item from the drop-down menu.

The Report Name box is populated as you enter data into the Portfolio and Benchmark data fields.

Make selections in the lower section of the New Report window and click on the OK button.

This will open the Settings window where you may set up more refinements for your report. After making any adjustment click on the Ok button in the Settings window.

This will open a Performance Attribution Window.
Performance Attribution Window

The *Performance Attribution Window* consists of three sections: the header with a menu bar, a Views menu column and the main display area.

Header Menu Bar

The header menu bar consists of the following selections: **File**, **New**, **Favorites**, **Help** and a search function. The search function is similar to the search function in the main Morningstar Direct window. See page 5 for information about the search function.

**File**

The **File** menu selection has two items: **New Folder** and **Exit**. The **Exit** selection will close the *Performance Attribution Window*. The **New Folder** selection will open the **New Folder** window. See page 17 for information about the **New Folder** window.

**New**

The **New** menu bar selection has four selections: **Charts** (with two items in a sub-menu: **Return vs Category** and **Risk/Reward**), **Account Group**, **Model Portfolio**, **Strategy**, and **Advanced Search** (with one item in a sub-menu: **Unit Investment Trust**). The **Account Group**, **Model Portfolio** and **Strategy** selections currently do not perform any function.

The two **Charts** selections will open the *Select Investments* window. See page 18 for information about the operation of the *Select Investments* window. After setting up the *Select Investments* window, click on the **OK** button. This will open the selected chart in a new chart window.

The **Unit Investment Trust** selection under **Advanced Search** will open an advanced search window. See page 8 for information about this window.

**Favorites**

The **Favorites** selection has two items in its menu: **Add to Favorites** and **Delete Favorites**. These selections will open the **Add to Favorites** or **Delete Favorites** windows. These windows operate in the same manner as the **Add to Favorites** and **Delete Favorites** in the main Morningstar Direct program menu bar **Favorites** selection (see page 38).

The selections in the *Performance Attribution Window* menu bar do not add or delete favorites to the *Performance Attribution Window* but instead add them to the **Favorites** list in the main Morningstar Direct program.
Help

The Help selection has five selections: Contents/Index, Contact Us, Disclaimers, Subscription Agreement, About Morningstar Direct, and HttpClient Log. These are the same selections that are in the main Morningstar Direct program menu bar. See page 47 for information about the Help menu.

Views Menu Column

The Views menu column has nine selections: Highlights (the default display), Attribution, Contribution, Highest/Lowest, Portfolio Statistics, Trailing Performance, Valuation by Data Point, Weights, and Report Data.

Each of these selections will open a display with a different table of information, pertinent to the selection. Each display will have a header with a menu bar. The menu bar selections in the display area vary according to the selection being displayed.

The menu selections available are: Settings, Calculate, Export, Save, and Summary PDF.

Settings

The Settings menu has two selections: Reports and Views. Both selections open the Settings window. This window has two selections: Report Settings and View Settings. The Reports and Views selections will open the two different selections in the Settings window.

The two Settings window displays allow you to change the settings for the report and the views in the Performance Attribution Window.

When finished adjusting your selections click on the OK button.

This will return you to the Performance Attribution Window.

Calculate

The Calculate menu selection will cause the Performance Attribution Window to recalculate all data points, on all pages. This will include any changes you may have made using the header menu selections or just update to show the most recent market status.

Export

The Export menu has two selections: All Views and Current View. Clicking on one of these selections will export the selected data into Excel. There are no intermediate steps. Excel will automatically open. The All Views selection will result in an Excel file with a data sheet for each Performance Attribution Window menu column selection.

Save

The Save menu selection will save the current configuration of data. If the report has not been previously saved you will have a window prompting you to name the report. Enter a name and click on the OK button.
Summary PDF

The **Summary PDF** menu selection will generate a PDF formatted version of the current page being displayed.

**Data Set**

The **Data Set** selection under the **New** menu will open the **Select Data Points** window. See page 26 for information about the operation of this window.

Use this window to set up a data set. Select the universe and the data point set. Select the individual data points by highlighting them in the Available Data Points box. Click on the **Add** button to move the selected data points to the Selected Data Points box.

Once in this box you may change the order in which they appear. You also have the option of changing the settings for the data points by highlighting a data point and clicking on the **Settings** button.

Once you have finished click on the **OK** button. This will open the *My Data Sets* display under the **Data Sets** selection in the **Workspace** topic in the Morningstar Direct menu column. Go to page 140 for information about the **Data Sets** selection.

**Note**

The **Note** selection under the **New** menu will open a *Morningstar Direct* window. This is used to create a note to associate with a security or other item.

The item is identified in the **Related to** data field. This data field has a menu (pictured) with a built-in search feature. Select the type and enter a term into the box and suggested items will be displayed.

You may name the note and select the effective date of the note. Type the note into the large data field in the lower section of the window. When you have finished click on the **OK** button.

This will save the note in the **Note Manager** selection of the **Workspace** topic in the Morningstar Direct menu column. See page 145 for information about the **Note Manager** selection.

**Basic Search** and **Advanced Search**

The **Basic Search** and **Advanced Search** selections under the **New** menu are explained under the Searching in Morningstar section of this user guide. Go to page 6 for the **Basic Search** and page 8 for the **Advanced Search**.
Favorites

The Favorites menu selection in the program header has eight selections in its drop-down menu. These are Add to Favorites, Delete Favorites, Chart Templates, Investment Lists, Performance Reports, Report Templates, Searches, and Universes.

Add to Favorites

Clicking on the Add to Favorites selection will open the Find Favorites window. To add a favorite to the favorites lists follow these steps:

First, select the type of favorite from the drop-down menu for the Type box.

As a type is selected the available records in that category are listed in the Available Records box.

Second, highlight the record you want to add to the list.

Third, click on the Add button to add the selected record to the Selected Records box.

You may remove records from the Selected Records box by using the Remove or Remove All buttons.

Finally, click on the OK button to add the records in the Selected Records box to the Favorites list.

Delete Favorites

The Delete Favorites selection will open the Delete Favorites window. To delete a favorite from the favorites lists follow these steps:

First, select the type of favorite from the drop-down menu for the Type box. As a type is selected the available records in that category are listed in the Available Records box.

Second, highlight the record(s) you want to remove from the list.

Finally, click on the OK button and the selected records will be removed from the favorites list.

Chart Templates, Investment Lists, Performance Reports, Report Templates, Searches, and Universes

The other selections in the Favorites menu (Chart Templates, Investment Lists, Performance Reports, Report Templates, Searches, and Universes) will display a list of existing favorites (if any) that are in the menu for that favorite.

Clicking on a favorite will open that item.
Tools

The **Tools** menu selection in the program header has nine selections in its drop-down menu. These are **E-mail**, **Object Attribute Assignments**, **Security Definition Master**, **Portfolio Management Settings**, **Notes Editor**, **Hypothetical Illustration**, **File Conversion**, **Import**, and **Screener** (with five more selections under it).

**E-mail**

The **E-mail** selection will open an *Activities* window. This is a feature that allows you to manage contact information. This information is available to all Morningstar Direct users in the Business Library and Financial Markets Center.
Object Attribute Assignments

The **Object Attribute Assignments** selection in the Morningstar Direct **Tools** menu will open the **Object Attribute Assignments** window. This window is used to modify the attributes of various items.

There are four different types of items you may modify. These are listed in the menu column on the left: **Strategy**, **Model Portfolio**, **Account**, and **Benchmark**.

If no object has been created in a particular category that window will not have a list when selected. (Such as the Strategy display at the upper right.)

The **Account** selection is pictured. The various selections operate in a similar manner as this display.

All accounts that have been created are listed in this display. To perform actions on one or more accounts click on the check box next to the one(s) on which you want to work.

The menu bar at the top of the display has four selections: **Action**, **Save**, **Export**, and **Print**. The **Account** selection also has a box with a drop-down menu with two selections: **Accounts by Positions** and **Transactional Accounts**. Both displays are similar.

The **Save** selection will save any changes you make to the checked items.

Clicking on **Export** will open the checked items in Excel.

The **Print** selection will print the checked items.

The **Action** selection has some items in a menu. Most of the four **Object Attribute Assignments** selections have similar items in this menu. The **Account** menu has three selections: **Edit**, **Apply to Selected**, and **Deselect All**.

The **Deselect All** selections will clear all check marks from the check boxes.
**Edit** will open an *Account* window, which may be used to modify the selected accounts. This window has a menu column on the left and a display area on the right. The menu column has four major selections: **Holdings Summary** (the default display when the window first opens), **General Settings**, **Imported Price/Return**, and **X-ray**.

The **Holdings Summary** display is a table of information about the account. The table is in ten columns.

The **General Settings** selection is similar to the *Account Basics* window (see page 29) and it allows you to make changes to the account settings.

The **Imported Price/Return** display shows any data that has been imported.

The **X-ray** selection has three items under it: **Stock Sectors**, **World Regions** and **Top 10 Holdings**. Each selection will give you a broad view of the selected topic. You may display the report in PDF format by clicking on **PDF Report** in the display header. The report will be displayed in a new window. See page 11 for information about the report window.

The **Apply to Selected** selection will open a sub-menu with a number of items. Some of the items on this menu will vary from one selection to another. The **Account** menu is pictured.

Each item will open a small window that will allow you to select different options concerning the account. For example, the **Currency** selection will open a **Select Setting Value** window with a box with a drop-down menu that allows you to select a currency to use in your account.

After selecting a currency click on the **Apply to Selected** button to close the window and return to the **Object Attribute Assignments** window.

You may do this with as many of the items you wish to modify.

When finished making any modifications you may **Save** the file, **Export** it to Excel or **Print** it. Close the **Object Attributes Assignments** window when you are finished.
Security Definition Master

The Security Definition Master selection in the Tools menu will open the Definition Master window.

This window has a menu column with three main selections: User Defined Securities, Morningstar Securities, and Customized Data. Each topic has one or two items under it.

Most of these selections operate in a similar manner. The Price Sources display is pictured.

Some selections will not display a list if nothing in that type has been created and saved.

The menu bar across the top of the display area has selections for Action, Save, Export, and Print. Other selections may have a securities wizard, Add Rows and Refresh.

The Action selection menu has three to six items in a drop-down menu (depending on the selection you are in—the menu from the Securities selection is pictured): Edit, Delete, Compute Monthly Trailing Returns, Merge Security, Deselect All, and Apply to All.

Delete will remove any rows that have been selected (check mark in the check box). Deselect All will remove all check marks.

The Compute Monthly Trailing Returns will open the Monthly Trailing Return Options window where you select the period to compute. Click on the OK button after selecting the start and end periods.

Add Rows will add a new row to the list.

Save will perform a save on any changes you may have made.

With nothing selected, Export will export the list to Excel. If you select one or more items, those items will be exported to Excel.

In a similar manner, with nothing selected, Print will print the list. If you select one or more items, those items will be printed.

Refresh will refresh the display.

The Securities Wizard selection will open a new window where you may set up a new security. Click on the Save button when you have completed filling in the various data boxes.
Portfolio Management Settings

The Portfolio Management Settings selection in the Tools menu will open the Settings window.

The Settings window lists some standard Morningstar instruments that you may modify.

The menu bar near the top of the screen has six selections: Action, New Setting, New Disclosure, Export, Print, and Refresh. The Export, Print and Refresh selections will perform the actions indicated. If no items have been selected the Export and Print selections will export or print the table. If one or more items have been selected Export and Print will export or print those items.

Action

The Action selection has a drop-down menu with four items: Edit (with one item in a menu—Edit Setting), Settings Assignments, Delete, and Deselect All.

Delete will remove any selected items. Deselect All will remove any check marks from all check boxes.

The Edit Setting selection will open the Report Setting window. You may use this window to change the settings for the display of reports.

The Settings Assignments selection will open the Object Attribute Assignment window. See page 40 for information about this window.

New Setting


These selections will open either the Report Setting (see above), Transaction Setting or Tax Lot Method Setting window. These windows allow you to change the settings for the selected action (i.e., Transaction or Tax Lot Method).

New Disclosure

The New Disclosure selection has a menu with one item: New Cover Page Disclosure. This will open the Disclosure Setting window. This page allows you to set up a disclosure.
Notes Editor

The Notes Editor selection in the Tools menu will open the same window as the Note selection under the New menu. Please go to page 37 for information about this window.

Hypothetical Illustration

The Hypothetical Illustration selection in the Tools menu will open a window where you may set the criteria for your hypothetical illustration.

This window has seven tabs: Investments, Buy, Advanced Buy/Sell, Reinvest/Reb (Rebalance), Fees, Taxes, and Report Options.

You set up your hypothetical illustration by starting in the Investments tab and selecting the items to include. Next go to the other tabs and set the parameters of your investment. When you have finished, save your work by clicking on the Save or Save As selections in the menu bar. Name your hypothetical illustration and click on the OK button.

File Conversion

The File Conversion selection in the Tools menu will open a window that allows you to convert aggregate and position accounts created in older versions of Morningstar Direct into formats that can be used with the later versions of the program.

The window lists items (aggregates, models, accounts) and gives you options for conversion. Select the conversion you want and click on the OK button.

Import

The Import selection in the Tools menu will open the Import window. This window lists some templates that you may use to import your data.

There are three selections in the menu bar for this window: Action (with Refresh Local Database and View Blotter in a menu), Import, and Edit Definition Master. The Import and View Blotter selections are used in conjunction with the templates listed.

Clicking on Refresh Local Database will refresh all data in the database.
Edit Definition Master will open the Definition Master window. This is the same window that is opened when the Security Definition Master selection in the Tools menu is selected. Please go to page 42 for information about the Definition Master window.

Import

Select the template you want to use by clicking on the check box next to the template. Then click on the Import selection. This will open an Import window for that template. Each template Import window is tailored to that template.

Use this window to enter your file’s name and path. You also use this window to set up the dates and other criteria.

You must ensure the columns of your file match the columns of the template.

When finished click on the OK button.

This will open another window with your data entered in a table. Any data lines that have a problem will be marked with a red symbol. You must correct these items before you can save the list into Morningstar.

Screener

The Screener selection in the Tools menu has a submenu with five items: Open End Funds, Stocks, Exchange Traded Funds, Closed End Funds, and Custom Universe. Each of these selections will open a filter feature that allows you to search for items that match criteria you select. Each of the screens are similar to the others and operate in a similar manner. The Stock filter is pictured.

The total number of items available is listed in the top line and in the bottom left corner. As filters are applied the number in the bottom changes to indicate how many items are left after the filter is applied.

The top line also has an Action menu with seven selections: Save Search, Open Search, Clear Search, Save Results as List, Save Results to List, Export Results, and Exit.

Exit will close the window. Clear
Search will remove any criteria and return the number to the original figure. Open Search will open a list of saved searches, if any have been saved. Selecting a saved search will display that data in the window.

Save Search will open a window where you name the search. Click on Save to complete the action.

Export to Excel will export the data into an Excel spreadsheet.

To use Save Results as List and Save Results to List you must select one or more items in your results list. You will be prompted to name a new list. To save to a list select one from the lists displayed.

Use the Add Search Filter button to begin filtering the list. This will open the Choose a Search Filter window. This window lists all the filters available. Each selection in the left column is a topic that will display only the filters in that topic. You may select as many filters, from as many topics, as you need. As you select each filter the filter is immediately applied and the number in the bottom corner is undated so you have a running indication of the results of each filter.

When you have finished selecting filters click on Close to remove the filter list window.

You may then use the items in the Action menu to save your results or start over.
Help

The Help menu selection in the program header has six selections in its drop-down menu. These are Contents/Index, Contact Us, Disclaimers, Subscription Agreement, About Morningstar Direct, and HttpClient Log.

Contents/Index

The Contents/Index selection will open a window with a standard Windows-type help feature. You may search for topics for help.

The opening page has links to a guide and information sheets in PDF format. These include Quick Start Guide; Coverage, Reports, and Presentations; Samples; and Technical Specifications Guide.

Each of these will be opened in the display area of the help window. The Quick Start Guide is a PDF document with more than 250 pages.

Contact Us, Disclaimers, Subscription Agreement, and About Morningstar Direct

The Contact Us, Disclaimers, Subscription Agreement, and About Morningstar Direct menu selections open windows with information pertinent to the topic.

HttpClient Log

The HttpClient Log selection is an on-off toggle.
Price Monitor

The Price Monitor selection on the menu bar will open a new window with four sections. Other users may have closed one or more list, leaving fewer sections. Each section displays a list.

Each list is in the form of a table. Sliding the scroll bar to the far right will display more columns of information and, in the upper right corner, five buttons. These buttons are: View Security Name, Add Securities, Remove Selected Securities, Save as an Investment List, and Close List.

The View Security Name button is a toggle that displays (or hides) the first column, which contains the name of the institution.

The Add Securities button will open the Select Investments window. See page 18 for information about the Select Investments window. After identifying an institution you click on the OK button to add the institution to the list. More than one may be added at a time.

Clicking on the Remove Selected Securities button will remove any item that you have marked by clicking on it. More than one item may be highlighted by holding the Control [Ctrl] key while clicking with the mouse.

The Save as an Investment List button will open a Save As window where you are prompted to name the list. It will then be added to the My Lists selection under Investments Lists in the Workspace topic of the Morningstar Direct menu column.

Close List will close the list, leaving three lists (or less if a list has already been closed). One list will expand to occupy the entire upper or lower half of the window.

Menu Bar

This window has a menu bar with three selections: File, New Window, and Help.

File

The File selection has one option, Exit. This will close the window.

Help

The Help menu has five selections. These are similar to the selections of the Help menu in the Morningstar Direct menu bar. See page 47 for information about the Help menu.
New Window

The **New Window** menu has two selections: **New List** and **Load**, which has four items in a sub-menu: **List**, **Account**, **Model**, and **Custom Benchmark**.

**Note:** Only four lists may be displayed at a time. One list must be closed before a new list can be opened.

The **New List** selection will open the *Find Investments* window. See page 19 for information about the *Find Investments* window. After making your selection of securities click on the **OK** button to close the *Find Investments* window and place the new list into the *Price Monitor* window.

The **List** selection will open the *Select Investment List* window where you select the item you want by highlighting it and clicking on the **OK** button. This will close the *Select Investment List* window and place the new list into the *Price Monitor* window.

Clicking on **Account** will open the *Select an Account* window where you search for the item you want and highlight it on the results list. Click on the **OK** button to close the *Select an Account* window and place the new list into the *Price Monitor* window.

The **Model** selection will open a *Select a Model* window. This window is similar to the *Select an Account* window. Select the item you want from a results list and click on the **OK** button to close the *Select a Model* window and place the new list into the *Price Monitor* window.

The **Custom Benchmark** selection will open a *Select a Custom Benchmark* window. This window is similar to the *Select an Account* window. Select the item you want from a results list and click on the **OK** button to close the *Select a Custom Benchmark* window and place the new list into the *Price Monitor* window.

**Note:** Any user of this database may access the *Price Monitor* feature and change or delete any lists that have been assembled.
Menu Column

The Menu Column has selections divided into 12 topic areas. These are: Home, Research Reports, Local Databases, Global Databases, Performance Attribution, Performance Reporting, Asset Allocation, Portfolio Management, Portfolio Analysis, Fund Flows, Presentation Studio, and Workspace.

Home


Home

The Home page displays general information grouped into sections. These include Announcements, Security Analysis, Alerts, Markets and Market Barometer. Most sections have More links that will open a new window with more links on the same topic.

The Home page may be modified to display other sections. Click on the Customize This Page link in the upper right corner of the page to access a new window with a long scrolling list of sections that you may choose to display. When you have finished making your selections, click on the Save & Close button to return to the Home page.

Alerts

Clicking on the Alerts selection will open the Alerts page. This page displays a list of all alerts that have been set up, if any.

Alerts are set up by selecting Alert from the New menu in the program menu bar or by selecting Price Alert in the Add menu in the Alert window. Both selections will open the Add Price Alert window. See page 22 for information about setting up alerts.

Please note that an e-mail notification request will not produce an e-mail to the person setting up the alert because an e-mail address is not entered. An alert would go to the subscription e-mail address on record.
Filings

Clicking on the Filings selection will open the Filings page. This page has the Morningstar Document Library.

You may use this page to access investment documents.

The page has a menu bar and a search function near the top of the page and a list of documents by country in the Global and Historical Coverage section on the right. There are also some active links in the Data Universes Available column.

The search function allows you to search for items in this section.

Start typing a term into the data field and a list of suggested items is displayed. Clicking on a name on this list will open the page for that item. The page for the Kellogg Company is pictured.

This page lists all the documents available for the company. The documents are available in a number of types, indicated by the tabs across the top of the page: Financials, Announcements, Ownership, Proxy, OfferingStmts (Statements), Insider Activities, and Other.

The Format column on this page has active links to the documents. The documents are available in several formats, the icon indicates the format, whether in PDF or HTM. Clicking on the icon will open the document in a new window.

The Filings page menu bar has selections for Home (returns you to the Filings Home page), Fund Documents (with eight selections), Corporate Reports, and Institutional Filings (with two selections).
The selections in the menus and the links in the Data Universes Available column all open similar pages. The Mutual Fund page is pictured.

The data is displayed in a table format. The items in the Name, Last Document, and Quick View columns are active and will open documents in a new page.

The entity name will open the page for that entity. This page has a list of documents that are available. The icons in the Format column will open documents in a new window.

The Quick View link near the top of the page will open the same document as the icon in the Quick View column on the main page (Mutual Fund page in this case). This Quick View page has links to several reports. The one pictured has three links: Prospectus (pictured), Semi-Annual Report and Annual Report. Clicking on one of the links will display that document. Other Quick View pages may have different reports available.

The entries in the Last Document column on the Mutual Fund page (in this case) are an icon and the type of document. Both will open the same document in a new window. This document is the latest that is available for that entity. For a listing of all documents available click on the entity’s name in the Name column.

The Mutual Fund page (in this case) also has three boxes near the top of the page. These have drop-down menus that allow you to change the display of entities by changing the type of documents (six selections). The Search selection will open the Advanced Search page where you may select criteria for a detailed search. The results will be displayed in a table below the search function. This table is similar to the main page (Mutual Fund page in this case).

The other boxes allow you to change the location (long list of countries) or the time period being displayed. Making a selection will immediately change the display.
The Global and Historical Coverage column on the Filings page has a list of countries with entries in two columns: Mutual Funds and Equities. Each entry is a number indicating how many of the subject items are available for that country. These entries are links that will open the page for that item. The page that is opened is similar to the pages that are opened when selections are made from the Filings page menu bar selections or the Data Universes Available column. See page 51 for information about these pages.

Price Monitor

Clicking on the Price Monitor selection will open a new window with up to four sections. Each section displays a list.

This is the same window that is opened when Price Monitor is selected from the menu bar.

See page 48 for information about the Price Monitor feature.

Excel API

Clicking on the Excel API selection will open the Excel API page.

This page gives you information about the Excel add-in that may be downloaded. All computers in the Business Library with Morningstar Direct have had the add-in installed.

There is also a short training video and tips for using the Excel add-in.

Using the Excel Add-in

To use Excel with Morningstar Direct follow these steps:

Open Excel and click on the Add-ins menu selection.

In the Menu Commands section of the header bar click on the Morningstar Plug-in selection. This will display a menu with two items.

Click on the Templates selection.

This will open the Morningstar Plug-in for Excel web page. This page lists all the templates that are available.

Select a template and click on it. This will
open a File Download window. Click on the Open button.

This will open the template in an Excel worksheet.

Click on the Set List button in the worksheet.

**Note:** Some templates will not have the Set List button. In this case the Calculate button will already be active. Click on it to populate your worksheet with data.

This will open a log-in window for Morningstar. Enter the same log-in information that was used to log into the Morningstar Direct program. Click on the Log In button.

This will open a Morningstar agreement window. After reading the agreement click on the I agree check box and click on the Next button.

This will open the Morningstar Plug-In for Excel window. This window has three options: Saved Investment Lists, Saved Searches, and Manually Select Investments.

**Saved Investment Lists and Saved Searches**

The Saved Investment Lists and Saved Searches selections will populate the large box below the selections with the same lists that are in the Investment Lists and Search Criteria in the Workspace topic of the Morningstar Direct program menu column.

Select an item from a list and click on the Next button.

The list will be processed and the window will display a progress bar. Click on the Finish button.

This will place the information into the Excel worksheet. The second button (Calculate, Retrieve, etc.) in the Excel worksheet will now be active.

Click on the Calculate button. This will open a Settings window.

Click on the selections you want and, when finished, click on the OK button. This will populate the Excel worksheet with data.

**Manually Select Investments**

When using the Manually Select Investments selection in the Morningstar Plug-in for Excel window you must click on the Edit button beside the large box below the selections.
This will open a *Find Securities* window. See page 19 for information about using the *Find Securities* window. When you have finished selecting the items you wish to use click on the **OK** button.

This will return you to the *Morningstar Plug-in for Excel* window. Click on the **Next** button.

After this the process is the same as for the *Saved Investment Lists* and *Saved Searches* selections. See the previous page for information about this process.

**Help/Definitions**

Clicking on the **Help/Definitions** selection will open the *Help/Definitions* page. This page has a list of documents about Morningstar. The document name and icons in the last column are links to documents.

**Morningstar Publications**

Clicking on the **Morningstar Publications** selection will open the *Morningstar Publications* page. This page has a list of documents about Morningstar. The last column contains links to documents.

**Content catalog**

The **Content Catalog** selection in the **Home** topic of the menu column will open the *Content Catalog* page. This page has four tabs near the top of the page: **Indices**, **References**, **Research** and **Database**. Each tab will display a list of items included in the Morningstar database.

The **Indices** tab has a long list of indices. Each index listed is a link that will display an information page about that index.

The other tabs have short lists with no links.

**Training**

The **Training** selection has a sub-menu with four items: **Live Sessions**|**Videos**|**User Guides**, **Classroom Trainings**, **Did You Know?**, and **Certification**.

**Certification**

The **Certification** selection opens a display with a list of courses you may take. Each course has icons in the columns to indicate what options are available (i.e., Live Sessions, View Videos, Save Videos, User Guides, or Test).
To start a course click on the link in the User Guide column. Morningstar Direct recommends you have the Morningstar Direct program open and follow along to better help you understand the lesson. It is also recommended that you take the courses in the order listed.

If you need more information about a course click on the link in the View Video column. After finishing a course take a test by clicking on the link in the Test column.

You must have a score of 75% or higher to pass the exam. You may retake an exam if needed.

Some courses have online seminars that you may use if you need more help.

This certification process is a function of the individual user and not the Business Library. Also, since there are no individual accounts there may be difficulty in tracking individual certifications (names are required to take a test and register for courses).

**Live Sessions|Videos|User Guides**

The Live Sessions|Videos|User Guides selection will open a display with a list of webinars that are available. Each takes between 15 to 60 minutes. The links in the various columns indicate what options are available (e.g., Live Sessions, Videos, and Reference Materials).

You may change the display to show only those courses included in a specific topic by selecting a topic from the Topic menu in the header.

**Classroom training**

The Classroom Training selection will open a display with a list of training courses that are being offered in various locations around the country. Enrolling patrons in these courses is not a function of the Business Library. If a patron wishes to participate in one of these courses the patron is responsible for setting up the session.

**Did You Know?**

The Did You Know? selection will open a page with a list of items in the Morningstar database. Each line has a link in the Document column. This will open a document in a new window.

**Feedback**

The Feedback selection in the menu column has a sub-menu with two items: Messages and Settings. The Messages selection will open a display with messages that have been sent/received concerning the database. Since there is no individual logon for patrons, any messages may be viewed by all users. The Settings selection will open a page with some very simple selections for the feedback feature.
Research Reports

The Research Reports topic area of the menu column has three selection: Reports - Equity/Credit, Reports - Alternatives and Earnings Estimates. The content on the Reports - Equity/Credit page is not available with the current subscription.

The Reports - Alternatives selection opens a page with a list of available reports. The entries with icons in the various report columns will open the report in a new window.

The Earnings Estimates selection opens the Earnings Estimates page. This page has two tabs (Quarterly and Annual). The page opens with the Annual tab displayed. The Quarterly tab display is similar to the top part of the Annual tab.

The Annual tab is divided into eleven topics. Each topic may be expanded by clicking on the topic name. the topics are: Adjusted EPS (Earnings Per Share) (this topic is also on the Quarterly tab), Reported EPS, Target Price, Cash Flow Per Share, Revenue, EBITDA (Earnings Before Interest, Taxes, Depreciation, and Amortization), Adjusted Pre-Tax Profit, Reported Pre-Tax Profit, Adjusted Net Income, Reported Net Income, and Long Term Growth Rate.

Each topic will display a table and chart similar to the Adjusted EPS topic pictured. The data will be specific to the selected topic.

Local Databases

The Local Databases topic area of the menu column has nine selections: Morningstar Analysis, Funds/Managed Products, Stocks, Bonds, Ownership Analysis, Economics, Market Analysis, People, and Institutions.

Each major section of the Local Databases topic will display a submenu of more selections when that section is opened. The Funds/Managed Products submenu of 19 items is pictured.

As each item is selected, a list of the universes included in that item selection is opened in the display area.
The **Stocks** selection of the **Stocks** topic area is pictured at right. The **Stocks** selection has five universes listed. The list includes the name of each universe and the number of entities included in each universe.

Clicking on the name of a universe will open a display listing all the entities included in that universe.

**Universe Page**

The **United States Preferred Stocks** universe is pictured. All entities included in the universe are included in the table displayed. The data presented in the columns may be modified using the selections in the tool bar. All universe pages have the same tool bar across the top of the display. This tool bar has the following items: **Action** (with a drop-down menu), **View** (with a drop-down menu), **Save**, **Search**, **Edit Data**, **Sort**, **Locate**, **Export**, **PDF**, and **Refresh**.

**Action**

The **Action** menu has 11 items on it: **Save As** (with two selections on a submenu), **Add To** (with one selection on a submenu), **Settings** (with four selections on a submenu), **Reports** (with six selections on a submenu), **Charts** (with 14 selections on a submenu), **View Owners** (with two selections on a submenu), **Average Detail Report**, **Stock Intersection**, **X-Ray**, **Filing**, and **Reset Universe** (grayed out until the universe has been modified).

**Save As**

The **Save As** menu item has two selections under it: **Investment List** and **Performance Report**. Using one of these selections will save the selected entities (entities are selected by clicking on the check boxes next to each entity) in the form selected. Each will be saved to the area of the program associated with the selected type (i.e., investment list in the **Investment Lists** selection under the **Workspace** topic in the menu column—see page 128 for information about investment lists).

**Add To**

The **Add To** menu item has one selection under it: **Investment List**. This selection will add the selected entities to an existing list. After clicking on your menu selection a list of existing investment lists will be displayed. Select the one to which you want to add your current selections and click on the **OK** button. You will then be prompted to make data selections for the list. Click on the **Finish** button to complete the action.

You may check the new item by going to the area of the program concerning the type of item modified (i.e., Investment List in the **Investment List** selection under the **Workspace** topic of the menu column—see page 128).
Settings

The **Settings** menu item has four selections under it: **Hide Benchmark**, **Select Benchmark**, **Show Average**, and **Select Default Currency**. These selections allow you to hide a benchmark (if one has been selected—if one has it will be listed on the first line of the table), select a benchmark, show (or hide) an average (if the average is being shown it will be on the first line of the table), or select the currency to use in the table.

Reports

The **Reports** menu item has six selections under it: **Investment Detail**, **Quicktake**, **Quicktake PDF**, **Ownership HTML**, **Ownership PDF**, and **My Templates**.

The **Investment Detail**, **Ownership HTML**, **Ownership PDF**, and **My Templates** selections will each open a report window with the requested information. You may name and **Save** this report or **E-mail** it by using the **Report Title** box and the buttons across the top of the window. Reports are saved to the **Saved Reports** selection under the **Workspace** topic in the Morningstar Direct menu column in the main Morningstar screen (see page 145). You also have the option to print the report using the Acrobat Reader controls in the display area.

The two **Quicktake** selections will open the **Company Page** for the entity selected. See page 10 for information about the **Company Page**.

Charts

The **Charts** menu item has 14 selections. These selections will open a chart in a new window displaying the information requested.

View Owners

The **View Owners** menu item has two selections: **Detailed Owner Analysis** and **Peer Owner Analysis**.

To use the **Detailed Owner Analysis** selection you must have one item in the universe list selected (a check mark in the check box by the item). More than one item being checked will open a message window telling you to select only one item.

The **Detailed Owner Analysis** selection will open a **Morningstar Direct** window with a list of the owners of the selected item’s stock.

You may export, search the list, and open the list in PDF format. In PDF format you may save, e-mail or print the information.
The Peer Owner Analysis selection will open the selected items in a new Morningstar Direct window. Information about each item selected will be displayed in a separate column.

Average Detail Report

The Average Detail Report selection will open a report in PDF format in a new window.

This report will be on the average of however many items you selected (a checkmark in the check box by each item). This report may be saved, printed or e-mailed from the new window.

Stock Intersection

The Stock Intersection selection will open a Stock Intersection window. This window will display a table of information covering each item selected (a check mark in the check box next to each item in the universe list). This list may be exported or displayed in PDF format in a new window. This window may be printed, saved or e-mailed.

X-Ray

The X-Ray item in the Universe page Action menu will open an X-Ray window. This window displays a report that includes all the items you had selected from the universe list.

The X-Ray window has four tabs: Asset Allocation, Stock Sectors, World Regions, and Top Stock Holdings. Each tab gives you a broad view of the selected items.

You can display the report in PDF format by clicking on PDF Report in the page header.
Filing

The **Filing** item will open a new window from the Morningstar Document Library (**Filings** selection under the **Home** topic—see page 51) with a listing of documents pertaining to your selection. Only one item at a time may be selected from the universe list.

This new window has six tabs: **Financials**, **Announcements**, **Ownership**, **Proxy**, **OfferingStmts** (Statements), and **Insider Activities**. Each tab will display a different set of documents.

Each display is similar in that the list is a table with each document occupying a row. The last column of each table has icons indicating the format in which the document is available (i.e., HTM or PDF). Clicking on the icon will open the document in a new window.

Reset Universe

The **Reset Universe** item is only active if you have made any changes in the universe. Clicking on this item will reset the universe to its default configuration.

View

The **View** box in the **Universe** page tool bar has a drop-down menu with numerous selections. Each selection will display a different aspect of the universe. The **Snapshot** selection is displayed when the **Universe** page is first opened.

Selecting an item from the menu will change the data columns to display data pertinent to the selected topic (i.e., **Growth**).

Save

The **Save** selection in the **Universe** page tool bar opens a **Save As** window that prompts you to name the Universe. After entering a term in the **Name** data field click on the **OK** button to save the universe. This is particularly useful if you have made changes to the universe and wish to continue using this new universe at a later date.

Your saved universe will be located in the **My Search Criteria** selection of the **Search Criteria** menu under the **Workspace** topic in the Morningstar Direct menu column. See page XXX for information about the **Search Criteria** menu.

Search

The **Search** selection in the tool bar will open an advanced search window for the specific universe in which you are working.

Please go to page 8 for information on the advanced search window.
Edit Data

The **Edit Data** selection in the tool bar will open the *Select Data Points* window. You may use this window to change the general or calculation settings of the data points you select. See page 26 for information about the *Select Data Points* window.

Sort

The **Sort** selection in the tool bar will open a window where you may set up the primary and secondary ranking for the universe. Click on the **OK** button when you have finished making your selections.

Locate

The **Locate** selection in the *Universe* page tool bar will open the *Select a Security* window. This window opens with the universe in which you are working already selected in the **Within** box. You may select a different universe from the menu.

The **Find By** box allows you to select what you are looking for (i.e., **Name**, **Ticker**, etc.).

Entering a term into the search box and clicking the **Go** button will search the selected universe for that item.

The Available Records section lists all the records in the selected universe. Once you click on the **Go** button the list of records includes only those that meet your search criteria. You may select an item from this list. With a record selected click on the **OK** button. This will place a check mark in the check box for this company in the selected universe.

Export

The **Export** selection in the tool bar will export the selected items to Excel. If you do not select any items the **Export** function will try to export the entire universe. Only the information displayed on the *Universe* page will be exported.

PDF

The **PDF** selection in the tool bar will create a PDF report of the selected items. The report will be displayed in a new window in PDF format. If you do not select any items the **PDF** function will try to create a report of the entire universe. Only the information displayed on the *Universe* page will be included in the report.

Refresh

The **Refresh** selection in the tool bar is used to refresh the data displayed on the *Universe* page.
Global Databases

The **Global Databases** topic area of the menu column has eight selections: **Morningstar Analysis**, **Funds/Managed Products**, **Stocks**, **Bonds**, **Ownership Analysis**, **Economics**, **Market Analysis**, **People**, and **Institutions**.

Each major section of the **Global Databases** topic will display a submenu of more selections when that section is opened. The **Morningstar Analysis** submenu of two items is pictured at right.

As each item is selected, a list of the universes included in that item selection is opened in the display area.

The **Closed End Funds** selection of the **Funds/Managed Products** topic area is pictured at right. The **Closed End Funds** selection has twelve universes listed. The list includes the name of each universe and the number of entities included in each universe.

Clicking on the name of a universe will open a **Universe** page listing all the entities included in that universe. See page 58 for information about the **Universe** page.
Performance Attribution

The Performance Attribution topic area of the menu column has two main selections: Equity Attribution and Total Portfolio Attribution.

Equity Attribution

The Equity Attribution selection has three items under it: Single Portfolio (with two items in a submenu), Multiple Portfolios and Archived Reports.

Single Portfolio

The Single Portfolio selection has two items under it: Folders and All Reports. The selection opens with the Folders page displayed. The All Reports selection will open the All Reports page. The Folders and All Reports pages are identical.

Each page lists portfolios that have been saved.

Double clicking on a portfolio name will open a Performance Attribution Window. See page 35 for information on the Performance Attribution Window.

The Folders and Reports pages have headers with a menu bar with five selections: Action (with 14 items in a submenu), New, Templates, Custom Grouping, and Learn More.

Action

The Action selection menu has 14 items: Calculate, Export, Calculate & Export, PDF, Delete, Rename, Schedule, Refresh Scheduled Tasks, Clear Schedule, Archive Report, Save As, Send To, Assign to Folder, and Single Portfolio Tutorial.

Calculate will calculate the values of the selected reports. After completing the calculation you will be asked if you want to view the report. If you do, it will be opened in a Performance Attribution Window. See page 35.

Export will export a selected report to Excel. This will include all the data included in the Performance Attribution Window.

Calculate & Export will calculate the values of a selected report and export it to Excel. This ensures the exported report has the most current data.

The PDF selection will display the selected report in PDF format.

Delete will delete any selected report.

Rename allows you to rename any selected report.
The **Schedule** selection will open the *Batch Management* window. This window allows you to set up a scheduled event for the selected reports. The event may be one time or repeated.

After setting up the event click on the **OK** button. Please be aware that this feature will send any scheduled exports to a local computer, not necessarily the one on which it was set up.

**Refresh Scheduled Tasks** will refresh any tasks scheduled for the selected report.

**Clear Schedule** will clear any scheduled tasks for the selected report.

**Archive Report** will save any selected reports in the *Archived Reports* page. See page 74.

**Save As** will prompt you to save a selected report with a new name. It will then be added to the My Reports list. The report with the original name will remain on the list.

The **Send To** selection will send a selected report to a recipient either inside or outside your firm. The **Within My Firm** selection will open will open a *Find Users Within My Company* window. This window searches for users within the firm. Click on a user and then the **OK** button to send the report.

The **Outside My Firm** selection will open a *Send Copy To* window where you enter the recipient’s e-mail address.

**Assign to Folder** opens the *Assign to Folder* window where you are prompted to select the folder to drop the selected report into.

The **Single Portfolio Tutorial** selection will open the *Single Portfolio* window. This window has four links to training features.

- **Open Video Tutorial** will open a video training tutorial in a new window. This video takes about 30 minutes to view.

- **Open PDF Tutorial** will open a tutorial in PDF format.

- **Open Methodology Video** will open a recorded presentation on the methodology of performance attribution. This video takes about 50 minutes to view.

- **Open Methodology PDF** will open a PDF tutorial.

**New**

The **New** menu bar selection will open the *New Report* window. See page 33 for information about the *New Report* window.
Templates

The **Templates** menu bar selection will open the **Templates** window. The **Templates** window is divided into two sections: Morningstar Templates and My Custom Templates. Each section lists the templates that are available. The My Custom Templates section is inactive until at least one template has been saved.

The **Templates** window has a menu bar with three selections: **New Template**, **Delete Template**, and **Edit Template**.

The **New Template** menu selection will open a **Settings** window.

Double clicking on a template name in the list also will open a **Settings** window.

See page 36 for information about the **Settings** window.

The **Delete Template** selection will delete the selected template from the list. You may only delete saved custom templates.

The **Edit Template** selection will open the **Settings** window with information from the selected template already entered. You may then change the name and modify the criteria to suit your needs.

Clicking on the **Save** button will save the new template in the My Custom Templates section of the **Templates** window.

Custom Grouping

The **Custom Grouping** menu bar selection will open the **Custom Grouping** window. The **Custom Grouping** window is divided into two sections: Morningstar Numeric Rule-Based Groups and My Numeric Rule-Based Groups. Each section lists the groups that are available. The My Numeric Rule-Based Groups section is inactive until at least one grouping has been saved.

The **Custom Grouping** window has a menu bar with three selections: **New Grouping**, **Delete Grouping**, and **Edit Grouping**.
The **New Grouping** menu selection will open a *Security Classification* window. Select the data point you want to use in your grouping and click on the **OK** button. This will open a *Numeric Rule-Based* window.

Double clicking on a group name in the list also will open a *Numeric Rule-Based* window (with the settings from that grouping already entered).

The *Numeric Rule-Base* window allows you to set up the criteria for your new grouping. Click on the **Save** button to add the new grouping to the My Numeric Rule-Based Groups list.

The **Delete Grouping** selection will delete the selected grouping from the list. You may only delete saved groupings.

The **Edit Grouping** selection will open the *Settings* window with information from the selected template already entered. You may then change the name and modify the criteria to suit your needs.

Clicking on the **Save** button will save the new grouping in the My Numeric Rule-Based Groups section of the *Custom Grouping* window.

**Learn More**

The **Learn More** menu bar selection will open the *Latest Available Documents* window. This lists all the latest information available. The title of each document is a link that will open the document. Each document explains some aspect of attribution.

The icons in the Methodology column will open a document in PDF format explaining the methodology concerning that aspect.
Multiple Portfolios

The **Multiple Portfolios** selection of the **Equity Attribution** section of the **Performance Attribution** topic will open the **Multiple Portfolios** page.

This page is blank until a multiple portfolio is saved.

The **Multiple Portfolios** page has a header with a menu bar with three selections: **Action** (with 12 items in a submenu), **New**, and **Learn More**.

**Action**

The **Action** selection menu has 12 items: **Calculate**, **Export**, **Calculate & Export**, **Delete**, **Rename**, **Schedule**, **Refresh Scheduled Tasks**, **Clear Schedule**, **Archive Report**, **Save As**, **Send To**, and **Multiple Portfolios Tutorial**.

These selections perform similar actions as the same selections in the **Action** menu for the **Folders and All Reports** pages. See page 64 for information about this menu.

The **Multiple Portfolios Tutorial** selection will open the **Multiple Portfolios Tutorial** window. This window has two links to training features.

- **Open Video Tutorial** will open a video training tutorial in a new window. This video takes about eight minutes to view.
- **Open Sample Excel Output** will open a sample output in Excel.

**Learn More**

The **Learn More** selection will open a **Latest Available Documents** window. See page 67 for information about this window.

**New**

The **New** selection will open the **Select Multiple Portfolios** window. This window allows you to select multiple portfolios. It is similar to and operates in a similar manner as the **Find Investments** window. See page 19 for information about the **Find Investments** window.
Once you have made your selections click on the OK button. This will open the Group Settings window where you may adjust the settings of the new group.

You may move groups up or down the list by selecting the group and clicking on the up or down arrows in the menu bar.

The Expand All selection will display the contents of each group.

Report Settings will open the Report Settings window. This window has numerous selections that affect the display and output appearance of the report. Click on the OK button to close the window.

The Delete selection will delete any selected groups.

Custom Groups will open the Custom Group Settings window. You may use this window to name the custom group, add any ungrouped investments or remove any of the items in your custom group. Click on the OK button when you are finished. This returns you to the Group Settings window.

The Show Benchmarks selection will show the benchmarks for the items in the Group Settings window.

When you have finished making any adjustments in the Group Settings window click on the OK button. This will open the Select Columns window. This window allows you to select either User Defined or the settings from an existing report. Selecting Existing Reports will activate the drop-down menu, which will have a list of available reports. Select one from the list and click on the OK button.

This will open the Untitled Multiple Portfolios Report page. Selecting User Defined in the Select Columns window and clicking on the OK button will open the Time Period Setup window.

The Time Period Setup window allows you to make selections in Time Periods, Attribution Calculation, Portfolio Statistics and Ranks. After making any adjustments click on the OK button.
This also opens the Untitled Multiple Portfolios Report window. This page is the same as the named Multiple Portfolios report page that is opened when you click on an entry on the Multiple Portfolios page.

This page has a menu bar with 12 selections: Action (with a menu of 18 items), Save As, Group Settings, Report Setup, Supplementary Columns, Calculate, Export, Locate, Sort, Undo, Save, and View (with three items in a menu).

Action

The Action menu has selections for Add Investments, Delete Investments, Expand/Collapse All Groups, Highlight, Conditional Format, Filter, Report Settings, Manage Columns, Detailed Attribution, Detailed PDF, Reports, Charts, Archive Report, Calculate and Export, Save, Save As, Save As Investment List, and Recently Used Reports.

The Add Investments selection will open the Select Multiple Portfolios window. This window allows you to select multiple portfolios. It is similar to and operates in a similar manner as the Find Investments window. See page 19 for information about the Find Investments window. Clicking on the OK button will add the selected items to the current list.

Delete Investments will remove any selected items.

Expand/Collapse All Groups will expand or collapse all the groups on the list, showing only the headings.

The Highlight selection has seven items in a menu. These allow you to highlight selected rows in the color of your choice. There are also selections to remove highlighting.

Conditional Format has a menu with three items. The Conditional Formatting selection opens the Conditional Formatting Rules window. This window is used to set up rules for selected columns (using the Field Name menu). After setting up a rule click on the OK button to return to the Multiple Portfolios window. The Add Rule button will add another row to the window so additional rules may be created.

The Conditional Format menu also has selections to enable or disable all rules.

The Filter selection has a menu with three selections: On, Off, and Edit. The first two will turn any filters on or off. The Edit selection will open the Filter window.
The Filter window is used to set up filters. This window is similar to the Advanced Search window. See page 9 for information about setting up the criteria.

The Report Settings selection of the Action menu will open the Report Settings window. This window has numerous selections that affect the display and output appearance of the report. Click on the OK button to close the window.

The Manage Columns selection will open the Manage Columns window. This window is used to rename, reorder and hide the columns in your report. To rename a column click on the column name. this will make that entry active. You may then type in a new name.

To reorder the columns select the one you want to move and click on the up or down arrows in the header to move the selected column.

You may hide a column by clicking on the check mark in the Show column so that the check mark disappears. Only those columns with check marks in the check boxes in the Show column are displayed in the report.

Click on the OK button to apply any changes.

The Detailed Attribution and Detailed PDF selections do not perform any function at the current time.

The Reports selection has a menu with 13 items. Clicking on a report name will open a Report window with the selected report. See page 11 for information about the Report window.

The My Templates selection will open the Select My Template window. This window lists all the templates available. Click on the template you want your report formatted in and click on the OK button. The report will be displayed in a Report window. See page 11 for information about the Report window.
The **Charts** selection in the **Action** menu has a menu with 17 items. Clicking on a chart name will open a window to set up the chart.

Selecting **Floating Bar**, **Scatterplot** or **Time Series** will open the **Select Data Points** window. See page 26 for information about the **Select Data Points** window.

Clicking on the **OK** button will open the **Floating Bar** window. Information about the **Floating Bar** window is also found on page 26.

You must select a peer group in the **Floating Bar** window. When finished click on the **OK** button. This will open your chart in a new window.


The **Stacked Bar** selection will open the **Stacked Bar** window. This window is used to adjust your settings and data. Clicking on the **OK** button will open a chart window for the Stacked Bar chart.

The **My Templates** selection will open the **Open From** window. This window lists any chart templates that may have been saved. Select a template and click on the **OK** button.

Your chart will be opened in a new window.

The **Archive Report** selection in the **Action** menu will archive the report. It is then listed in the **Archived Reports** selection of the **Performance Attribution** topic.

**Calculate and Export** will refresh the data for the report and export it to Excel.

**Save** and **Save As** will save the report. **Save** will save any changes you have made. **Save As** prompts you to give the report a new name.
Save as Investment List will prompt you to name the report. It will then be saved in the Investment Lists selection under the Workspace topic.

Recently Used Reports has a menu listing any recently opened reports. Clicking on the name of a report will open that report.

Group Settings

The Group Settings selection in the menu bar will open the Group Settings window. See page 69 for information about the Group Settings window.

Report Setup

The Report Setup selection will open the Time Period Setup window. The Time Period Setup window allows you to make selections in Time Periods, Attribution Calculation, Portfolio Statistics and Ranks. After making any adjustments click on the OK button.

Supplementary Columns

The Supplementary Columns selection in the menu bar will open the Supplementary Columns page. This page allows you to set supplementary data points using the three tabs: Supplementary, Historical, and Ranks. Each tab has a selection of columns that may be added to the report.

Available columns are listed in the top box. Select one and click on the Add button to move the column to the selected box.

The columns appear in the order in which they are listed. You may move the columns up or down the list using the arrows beside the box.

After making your selections click on the OK button. This will close the window and the report page will reflect any changes you may have made.

Calculate

The Calculate selection in the menu bar will refresh the data calculations in the report.

Export

Export will export the report to Excel.

Locate

The Locate selection will open the Select an Investment window. You may select an investment from the list in this window. If the list is long you may start typing a term into the Jump-To box. The list will scroll as you type. Select the item you want and click on the OK button.

The investment you chose will be selected in the report page.

Sort

The Sort selection allows you to sort the report page list according to the columns you want.
Undo

The **Undo** selection will undo all changes since the report was last saved, not just the most recent change.

Save

The **Save** selection will save any changes you may have made to the report.

View

The **View** data field menu has four selections: **Default**, **Group by Datapoint**, **Display Top Percentage**, and **Highlighted Rows**. Each selection will change the report page to display only the material selected.

Archived Reports

The **Archived Reports** selection (in both the Equity Attribution and Total Portfolio Attribution sections) opens the Archived Reports page. The Archived Reports page will list any reports that have been archived. If no reports have been archived the page will be blank. Reports may be archived by selecting a report on the Reports page (by clicking on the check box next to the report so that a check mark appears in the check box) and selecting **Archive Report** from the Action menu in the header.

Total Portfolio Attribution

The **Total Portfolio Attribution** selection in the menu column has four items under it: **Single Portfolio**, **Presentation Studio**, **Multiple Portfolios**, and **Archived Reports**.

Single Portfolio

The **Single Portfolio** page in the Total Portfolio Attribution section is similar to the Folders and All Reports pages in the Single Portfolio section of the Performance Attribution topic. See page 64 for information about the Folders page.

The **Total Portfolio Tutorial** selection of the Action menu will open the TPA window. This window has four links to training features.

- **Open Video Tutorial** will open a video training tutorial in a new window. This video takes about 10 minutes to view.
- **Open PDF Tutorial** will open a tutorial in PDF format.
- **Open Methodology Video** will open a recorded presentation on the methodology of performance attribution. This video takes about 48 minutes to view.
- **Open Methodology PDF** will open a PDF tutorial.

This **Total Portfolio Attribution Single Portfolio** page has a menu bar with four selections:
Action, New, Templates, and Learn More. The Action menu has similar selections as the Action menu from the Folders page. See page 64 for information about that Action menu.


The Templates menu bar selection will open the Templates window. This Templates window is similar to and operates in a similar manner as the Templates window from the Folders page. See page 66 for information about the use of the Templates window.

Clicking on the Learn More selection will open the Latest Available Documents window. See page 67 for information about this window.

Presentation Studio

The Presentation Studio selection in the Total Portfolio Attribution section will open a window with selections for various templates. There are three tabs on this page: Morningstar Templates, My Templates and Reports.

The Header has one selection: Report. This will open the Create New Report window. After making a selection in this window the Investments: Settings window will be opened. See page 108 in the Presentation Studio section for information about this page.

Clicking on a template name in the Morningstar Templates tab also will open the Investments: Settings window. See page 108 for information about this window.

The other tabs may not have any items if no personal templates or reports have been created.

Multiple Portfolios

The Multiple Portfolios selection in the Total Portfolio Attribution section will open a Multiple Portfolios page similar to the one opened in the Equity Attribution section of the Performance Attribution topic. See page 68 for information about the Multiple Portfolios page.

Archived Reports

The Archived Reports selection will open the Archived Reports page. See page 74 for information about this page.
Performance Reporting

The Performance Reporting topic area of the menu column has two main selections: Reports (with five items in a menu), and Batches.

Reports

The Reports selection has five items in a menu: Folders, All Reports, Inbox, Archive and Templates. The selection opens with the Folders page displayed. The All Reports selection will open the All Reports page. The Folders and All Reports pages are identical. The pages for the Inbox and Archive selections are similar and operate in a similar manner.

Each Folders and All Reports page list performance reports that have been saved.

Double clicking on a report name will open a report page. See page 78 for information about the report page.

The Folders and All Reports pages have a menu bar with four selections: Action, New, General Settings and a Quick Find box.

Action

The Action selection has a menu with 14 items: Calculate, Calculate and Export, Calculate and Export to Tabs, Stop Calculation, Stop All Calculations, Delete, Rename, Archive Report, Save As, Send To, Share With, Assign to Folder, Apply Template, and Recently Used Reports.

Calculate will perform calculations on all data for the selected report. Reports are selected by clicking on the check box next to each row. The date and time of the calculation will then be displayed in the Last Calculated column.

Calculate and Export will perform the calculation on the selected report and then export the newly calculated report to an Excel spreadsheet.

Calculate and Export to Tabs performs the same function as Calculate and Export.

Stop Calculation will halt the calculation of the selected report.

Stop all Calculations will halt all calculations.

Delete will delete the selected report.

Rename will allow you to rename the selected report.
Archive Report will send the selected report to the list in the Archived Reports selection under the Performance Reporting topic.

Save As will prompt you to save a selected report with new name. It will then be added to the list (Folders or All Reports page). The report with the original name will remain on the list.

The Send To selection will send a selected report to a recipient either inside or outside your firm. The Within My Firm selection will open a Find Users Within My Company window. This window searches for users within the firm. Click on a user and then the OK button to send the report.

The Outside My Firm selection will open a Send Copy To window where you enter the recipient’s e-mail address.

Share With will perform the same functions as the Send To selection. This selection also has a Release Report Lock selection in its menu that will unlock the report if it has been locked.

Assign to Folder opens the Assign to Folder window where you are prompted to select the folder to drop the selected report into.

The Apply Template selection will open the Load Template window where you may select a template from a list. Clicking on the OK button will apply the selected template to your report.

Recently Used Reports will open a list of reports that have been accessed recently. This includes a number of weeks, not just the current session.

New
The New selection in the menu bar will open the Select Investments window. See page 18 for information about using the Select Investments window.

General Settings
The General Settings selection will open the General Settings window. This window has numerous selections (in four tabs) that affect the display and output appearance of the report. Click on the OK button to close the window.
Quick Find

The **Quick Find** data field allows you to locate reports quickly if the list of reports is extensive. Start typing a term into the data field and a menu will appear with reports that include your term. As you type more characters the list is narrowed. Click on the item on the list and the page for that report will be opened. See below for information about the report page.

**Report Page**

Double clicking on a report name on the **Folders** or **All Reports** pages will open the **Report** page for that report.

---

### Menu Column—Performance Reporting

The **Report** page has a table of all the items included in the report. The columns (except for the **Name** column) are blank until the report has had a calculation performed on it. After a calculation has been performed the various cells are populated with data.

The top of the page has a menu bar with nine selections: **Action** (with a menu of nine items), **Save**, **Calculate**, **Edit**, **Undo**, **Locate**, **Tools**, **Export**, and **View** (with four items in a menu).
Action

The Action selection has nine items in a submenu: Add Investments, Delete Investments, Report Settings, Select Template, Select Report Currency, Reports, Charts, and Recently Used Reports.

The Add Investments selection will open the Select Investments window. See page 19 for information about the Find Investments window. Clicking on the OK button will add the selected items to the current list.

Delete Investments will remove any selected items.

Expand/Collapse All Groups will expand or collapse all the groups on the list, showing only the headings.

The Report Settings selection of the Action menu will open the Report Settings window. This window has numerous selections that affect the display and output appearance of the report. Click on the OK button to close the window.

The Select Template selection will open the Load Template window where you may select a template from a list. Clicking on the OK button will apply the selected template to your report.

Clicking on Select Report Currency will open the Select Currency window. This window allows you to select the currency you want to use from a long list of currencies.

The Reports and Charts selections are similar to and operate in a similar manner as the Reports and Charts selections in the Multiple Portfolios page in the Performance Attribution topic. Please go to page 71 for information about the Reports selection and page 72 for information about the Charts selection.

Recently Used Reports has a menu listing any recently opened reports. Clicking on the name of a report will open that report.

Save

The Save selection has a menu with five items: Save, Save As, Save as Template, Save as Investment List, and Archive.

Save and Save As will save the report. Save will save any changes you have made. Save As prompts you to give the report a new name.

Save as Template will prompt you to name the report. It will then be saved in the Template selection in the Performance Reporting topic.

Save as Investment List will prompt you to name the report. It will then be saved in the Investment Lists selection under the Workspace topic.

Archive will then be save the report in the Archive selection in the Performance Reporting topic.
Calculate

The **Calculate** selection has a menu with two items: **Calculate** and **Calculate and Export**.

The **Calculate** selection will refresh the data calculations in the report. **Calculate and Export** will refresh all the data calculations and export the data to Excel.

Edit

The **Edit** selection has a menu with six items: **Group Settings**, **Performance**, **Supplementary**, **Scorecard**, **Sort**, and **Manage Columns**.

**Group Settings** will open the **Group Settings** window. See page 69 for information about the **Group Settings** window.

The **Performance** selection will open the **Performance Column Setup** window.

This window has numerous selections (in three tabs) that affect the display and output appearance of the performance columns in the report. Click on the **OK** button to close the window.

The **Supplementary** selection will open the **Supplementary Columns** window. This window is used to add, edit, or remove columns in the report. Click on the **OK** button when you have finished.

The **Scorecard** selection will open the **Investment Scorecard** window. This window is used to create a custom scorecard by assigning weights to data points.

Enter the weight you want each data point to reflect by changing the percentage in the % Weight column. The percentages must total 100% Click on the **OK** button when you have finished.

The **Sort** selection will open the **Set Display Rank** window. This window allows you to set how the items in the record are sorted. You may select the primary and secondary ranks by making selections from the menus. Click on the **OK** button when you have finished.

The **Manage Columns** selection will open the **Manage Columns** window where you may rename, reorder or hide the various columns in the report.

Undo

The **Undo** selection in the report page header will remove the latest change you have made.
Locate

The Locate selection will open the Select an Investment window. You may select an investment from the list in this window. If the list is long you may start typing a term into the Jump To Record Name box. The list will scroll as you type. Select the item you want and click on the OK button.

The investment you chose will be selected in the report page.

Tools

The Tools selection in the header menu bar has a submenu with four items: Historical Scorecards, Highlight, Conditional Format and Filter.

The Historical Scorecards selection will open the Historical Scorecards window, if any scorecards have been created. Select the scorecard you want to view and click on the OK button.

The Highlight selection has seven items in a menu. These allow you to highlight selected rows in the color of your choice. There are also selections to remove highlighting.

Conditional Format has a menu with three items. The Conditional Formatting selection opens the Conditional Formatting Rules window. This window is used to set up rules for selected columns (using the Field Name menu). After setting up a rule click on the OK button to return to the Multiple Portfolios window. The Add Rule button will add another row to the window so additional rules may be created.

The Filter selection has a menu with three selections: On, Off, and Edit. The first two will turn any filters on or off. The Edit selection will open the Filter window.

Export

The Export selection will export the record to Excel.

View

The View data field menu has two selections: Default and Highlighted Rows. Each selection will change the report page to display only the material selected.
Templates

The Templates selection opens the Templates page.

This page lists the Morningstar prepared templates and any custom templates that may have been saved.

The page has a menu bar with three selections: Action (with five items in a menu), New, and General Settings.

Action

The Action menu has six selections: Delete, Rename, Save As, Send To, Share With, and Launch Wizard.

Delete and Rename allow you to delete or rename one of the templates. Note that these will not work on the Morningstar templates.

The Save As selection allows you to save a template under a new name.

The Send To selection will send a selected template to a recipient either inside or outside your organization. The Within My Firm selection will open a Find Users Within My Company window. This window searches for users within the organization. Click on a user and then the OK button to send the report.

The Outside My Firm selection will open a Send Copy To window where you enter the recipient’s e-mail address.

Share With will perform the same functions as the Send To selection.

The Launch Wizard selection will open the Performance Reporting Tutorial window. This window has two selections for opening training features to guide you through the process of creating a performance report.

The selections are: Open PDF and Proceed and Proceed With Tutorial.

The Open PDF and Proceed button will open a PDF document in a new window. This document gives you a written copy of the tutorial. The tutorial is an interactive presentation that walks you through the steps to set up a performance report.

The Proceed With Tutorial button opens the same tutorial. The tutorial instructs you how to proceed in a step by step fashion.
Using a Template

To use one of the templates, double click on the name of the template you want to use.

This will open the Select Investments window. See page 18 for information about using the Select Investments window.

The resulting report will be formatted in the form selected.

General Settings

The General Settings selection will open the General Settings window. This window has numerous selections (in four tabs) that affect the display and output appearance of the report. Click on the OK button to close the window.

Batches

The Batches selection can only have one computer designated for batch processing. The same computer must be used each time.
Asset Allocation

The Asset Allocation topic area of the menu column has one selection: Asset Allocation. This selection opens the Asset Allocation page.

This page has two tabs and two buttons in the menu bar.

The tabs are: Input Files and Case Files.

The buttons are: New Input and New Case. These buttons are displayed with both tabs.

There is also a menu symbol that will display a drop-down menu with seven or eight items. The menu for the Input Files tab has eight items: Share With, Send To, Save As, Delete, Asset Class Setup, Refresh, Send Feedback, and Sign Out. The menu for the Case Files tab is similar but has only seven items, the Send To selection is not included on this menu.

The Share With and Send To selections will open the Share File or Send File windows. These windows are used to set up the email address of the recipient. These selections will not work with the files with Morningstar ownership (Morningstar templates).

The Save As selection will open the Save As window that allows you to save the selected file under a new name.

Delete will remove the selected files. You may not remove the files with Morningstar ownership (Morningstar templates).

The Asset Class Setup selection will open the Asset Class Setup window. This window is used to set up a new asset class. You may select the class from the menu. The existing classes are listed in the lower part of the window. Classes may be renamed (so you can adjust the contents of an existing class without completely building a new one).

Refresh will update the list of files in the open tab.

Send Feedback will open an email blank for you to send information to Morningstar.

Sign Out does not perform any function at this time.
Input Files Tab

The Input Files tab lists all the input files. These include the Morningstar templates (Morningstar in the Owner column and Read Only in the Permissions column).

Clicking on a file will open the Asset Allocation File page in a new window. See page 86 for information about this page.

Case Files Tab

The Case File tab lists all the case files. This list also has Morningstar templates (Morningstar in the Owner column and Read Only in the Permission column).

Clicking on a file will open the Asset Allocation File page in a new window. This window is very similar to the page opened for the input files. See page 86 for information about this page.

New Input Button

The New Input button will open the Asset Class Selection window. This window is used to set up a new asset class. Select the class and the model from the drop-down menus. As sets are selected the list in the lower section changes. Once you have finished setting up your new input file click on the OK button to go to the next step.

This will open the next Asset Class Selection window. This window allows you to select Input Options, modify the Set-Up, and make Baseline Settings. This is done using the three tabs in this window. When finished click on the OK button.

Your new input file will be displayed in a new Asset Allocation File page. See page 86 for information about this page.

New Case Button

The New Case button will open the New Case window. This window is used to set up a new case. Select the input file from the drop-down menu. When ready click on the OK button.

Your new file will be displayed in a new Asset Allocation File page. See page 86 for information about this page.
Asset Allocation File Page

Once a file is selected in the **Input Files** tab, **Case Files** tab, or a new file is created the **Asset Allocation File** page is opened in a new window. The **Asset Allocation File** pages for Input Files and Case Files are similar and operate in a similar manner.

Both pages open with multiple screens displayed. The row of icons across the bottom of the page represent the screens that may be displayed. In the Input Files page pictured at right the line of icons consists of seven items. Four are already displayed. To add another screen use the mouse pointer to select and grab an icon and slide it onto the display area. The new screen will then be added to those already open.

The Input Files page has three workspace tabs (**Input Workspace**, **Optimizer Workspace** and **Forecasting Workspace**) across the top of the display area. Each tab will display a different set of screens. The Case Files page has only one tab: **Multiple Frontiers**.

In addition to this there is are three tabs across the top of the page (Inputs, Optimizer and Forecasting). Each tab will display a different set of tools in the toolbar below the tabs. The Case Files page has the same set of tabs and tools.

Each tool will give you a variety of options to modify the display and its content.
Portfolio Management

The Portfolio Management topic area of the menu column has seven selections: Strategies, Model Portfolios, Custom Benchmarks, Accounts, Account Groups, Securities Invested, and Saved Reports. The Accounts selection is displayed when the topic is first opened.

Strategies

The Strategies selection opens the Strategies page. The Strategies page has a menu bar with five selections: Action (with ten items in a submenu), New, Export, PDF, and Refresh. If no strategies have been saved the list will be empty.

Action

The Action menu has ten selections: Save As, Add To, Delete, View Holdings, X-Ray, Performance Attribution, Portfolio Analysis, Send To, Share With, and Assign to Folder.

The Save As selection allows you to save the selected strategy as an Account Group, an Investment List, or as a Duplicate Copy.

The Add To selection allows you to add the selected strategy to either an Account Group or an Investment List.

Delete will remove the selected (check mark in the check box next to the item to be removed) item.

The View Holdings selection has one item in a submenu: Detailed Holding Analysis. This will display an analysis of the selected strategy.

X-Ray will open the X-Ray window. Please go to page 60 for information about the X-Ray window.

The Performance Attribution selection of the Action menu has four items under it: Equity Single Attribution, Equity Multiple Attribution, Total Portfolio attribution, and Total Multiple Attribution. These are the same selections that are in the Performance Attribution selection in the New menu in the Morningstar Direct header bar. Please go to page 33 for information about the Performance Attribution menu selection.

Portfolio Analysis will open a page in Internet Explorer with extensive analysis of the selected item.

The Send To selection will send a selected report to a recipient either inside or outside your firm. The Within My Firm selection will open will open a Find Users Within My Company window. This window searches for users within the firm. Click on a user and then the OK button to send the report.

The Outside My Firm selection will open a Send Copy To window where you enter the recipient’s e-mail address.
Share With will perform the same functions as the Send To selection.

Assign to Folder opens the Assign to Folder window where you are prompted to select the folder to drop the selected report into.

New

The New selection will open a Morningstar Direct window where you may set up a new strategy.

Export

The Export selection in the tool bar will export the selected items to Excel. If you do not select any items the Export function will export the Strategies page.

PDF

The PDF selection in the tool bar will create a PDF report of the selected items. The report will be displayed in a new window in PDF format. If you do not select any items the PDF function will create a report of the Strategies page.

Refresh

The Refresh selection in the tool bar is used to refresh the data displayed on the Strategies page.

Model Portfolios

The Model Portfolios selection opens the Model Portfolios page. The Model Portfolios page has a header menu bar with six selections: Action (with 12 items in a sub-menu), New, Import, Export, PDF, and Refresh.

Action

The Action menu has 12 selections: Save As, Add To, Delete, View Holdings, Reports, Charts, X-Ray, Performance Attribution, Portfolio Analysis, Send To, Share With, and Assign to Folder.
Save As has four items in a submenu. This function allows you to save the portfolio as an Account Group, Investment List, A Duplicate Copy or as a Model Portfolio.

Add To has three items in a submenu. This function allows you to add the selected portfolio to an Account Group, Model Portfolio or an Investment List.

Delete will remove the selected (check mark in the check box next to the item to be removed) item.

The View Holdings selection has a submenu with one selection: Detailed Holding Analysis. To use the Detailed Holding Analysis selection you must have one item in the model portfolio list selected (a check mark in the check box by the item). More than one item being checked will open a message window telling you to select only one item.

The Detailed Holding Analysis selection will open a Morningstar Direct window with a list of the items in the selected portfolio.

You may export, search the list, and open the list in PDF format. In PDF format you may save, e-mail or print the information.

The Reports selection in the Action menu has a submenu with six items: Portfolio aggregation, HB Style Consistency, Investment Summary, Performance Evaluation, RB Style Analysis and My Templates.

Each of the report selections (the first five) will open the selected portfolio in the in the type of report selected. The report will be in a new window in PDF format with Adobe Reader style controls.

The My Templates selection will open the Select My Template window. Select the type of template and the report from the lists. Click on the OK button to open the report in the template selected.
The Charts selection has a submenu with 16 items: Correlation Matrix, Floating Bar, Growth, HB Style Map, HB Style Trail, Holdings Similarity, RB Style Trail, Return Bar, Return vs Category, Risk/Reward, Rolling Return (Bar), Rolling Return (Line), Scatterplot, Stacked Bar, Time Series and My Templates.

Each of the chart selections will open a new window with the chart of the selected portfolio displayed. See page 23 for information about the chart windows.

The My Templates selection will open the Open From window. This window will list any saved templates. Select a template and click on the OK button to open a chart of the selected portfolio using the selected template.

The X-Ray item in the Action menu will open an X-Ray window. This window displays a report of the selected portfolio.

The X-Ray window has four tabs: Asset Allocation, Stock Sectors, World Regions, and Top Stock Holdings. Each tab gives you a broad view of the selected items.

You can display the report in PDF format by clicking on PDF Report in the page header.

The Performance Attribution selection of the Action menu has four items under it: Equity Single Attribution, Equity Multiple Attribution, Total Portfolio attribution, and Total Multiple Attribution. These are the same selections that are in the Performance Attribution selection in the New menu in the Morningstar Direct header bar. Please go to page 33 for information about the Performance Attribution menu selection.

Portfolio Analysis will open a page in Internet Explorer with extensive analysis of the selected item.

The Send To selection will send a selected report to a recipient either inside or outside your firm. The Within My Firm selection will open will open a Find Users Within My Company window. This window searches for users within the firm. Click on a user and then the OK button to send the report.

The Outside My Firm selection will open a Send Copy To window where you enter the recipient’s e-mail address.

Share With will perform the same functions as the Send To selection.
Clicking on **Assign to Folder** will open a window with a list of folders from which you may select to put the selected portfolio into. Highlight the folder in the list so that the folder name appears in the **Name** data field and click on the **OK** button.

**New**

The **New** selection will open the *Model Portfolio Basics* window. This window is similar to and performs in a similar manner as the *Account Basics* window. Please go to page 29 for information about the *Account Basics* window.

**Import**

Use the **Import** selection in the header to import your document. Clicking on the **Import** selection will open the *Import* window. This window lists some predefined templates that you may use to import your data.

Select the template you want to use by clicking on the check box next to the template. Then click on the **Import** header selection or double click on the template name.

This will open a secondary *Import* window.

Use this window to enter your file’s name and path. You also use this window to set up the dates and other criteria.

You must ensure the columns of your file match the columns of the template.

When finished click on the **OK** button.

This will open another window with your data entered in a table. Any data lines that have a problem will be marked with a red symbol. You must correct these items before you can save the list into Morningstar.

**Export**

The **Export** selection in the menu bar will export the *Model Portfolios* page list to Excel. Only the list is exported.

**PDF**

The **PDF** selection will display the information in the *Model Portfolios* page in PDF format. Only the list is displayed, not the data in the reports.

**Refresh**

The **Refresh** selection will update the *Model Portfolios* page display.
Custom Benchmarks

The **Custom Benchmarks** selection in the **Portfolio Management** topic menu opens the **Custom Benchmarks** page. If no benchmarks have been created the page will display an empty list.

The **Custom Benchmarks** page has a menu bar with six selections: **Action** (with 12 items in a submenu), **New**, **Import**, **Export**, **PDF**, and **Refresh**.

**Action**

The **Action** menu has 12 selections: **Save As**, **Add To**, **Delete**, **View Holdings**, **Reports**, **Charts**, **X-Ray**, **Performance Attribution**, **Portfolio Analysis**, **Send To**, **Share With**, and **Assign to Folder**.

This action menu is similar to and operates in a similar manner as the **Action** menu on the **Model Portfolios** page. See page 88 for information about the **Action** menu and its various selections.

**New**

The **New** selection will open the **Benchmark Basics** window. This window is similar to and performs in a similar manner as the **Account Basics** window. Please go to page 29 for information about the **Account Basics** window.

**Import**

Use the **Import** selection in the header to import your document. Clicking on the **Import** selection will open the **Import** window. This window lists some predefined templates that you may use to import your data. See page 91 for information about the **Import** window.

**Export**

The **Export** selection in the menu bar will export the **Custom Benchmarks** page list to Excel. Only the list is exported.

**PDF**

The **PDF** selection will display the information in the **Custom Benchmarks** page in PDF format. Only the list is displayed, not the data in the reports.

**Refresh**

The **Refresh** selection will update the **Custom Benchmarks** page display.
Accounts

The Accounts selection opens the Accounts page. The Accounts page has a header menu bar with seven selections: Action (with 13 items in a submenu), New, Import, View Import Job Results, Export, PDF and Refresh. If no accounts have been created the list will be empty. Accounts are imported private strategies, client accounts, or any portfolios not in the Morningstar databases.

Action

The Action menu has 13 selections: Save As, Add To, Delete, Edit, View Holdings, Reports, Charts, X-Ray, Performance Attribution, Portfolio Analysis, Send To, Share With, and Assign to Folder.

This action menu is similar to and operates in a similar manner as the Action menu on the Model Portfolios page. See page 88 for information about the Action menu and its various selections.

The Edit selection will open the Account window for the selected account. See page 29 for information about accounts and page 30 for the Account window.

New

The New selection will open the New Account window. See page 29 for information about the New Account window.

Import

Use the Import selection in the header to import your document. Clicking on the Import selection will open the Import window. This window lists some predefined templates that you may use to import your data.

Select the template you want to use by clicking on the check box next to the template. Then click on the Import header selection or double click on the template name.
This will open a secondary *Import* window.

Use this window to enter your file’s name and path. You also use this window to set up the dates and other criteria.

You must ensure the columns of your file match the columns of the template.

When finished click on the **OK** button.

This will open another window with your data entered in a table. Any data lines that have a problem will be marked with a red symbol. You must correct these items before you can save the list into Morningstar.

**View Import Job Results**

The **View Import Job Results** selection is grayed out until you have imported a file. You may use this selection to view the imported data.

**Export**

The **Export** selection in the menu bar will export the *Model Portfolios* page list to Excel. Only the list is exported.

**PDF**

The **PDF** selection will display the information in the *Model Portfolios* page in PDF format. Only the list is displayed, not the data in the reports.

**Refresh**

The **Refresh** selection will update the *Model Portfolios* page display.

**Account Groups**

The **Account Groups** selection in the *Portfolio Management* topic opens the *Account Groups* window. If no account groups have been saved the list will be empty.

The page has a menu bar with five selections: **Action** (with six items in a submenu), **New**, **Export**, **PDF**, and **Refresh**.

**Action**

The **Action** selection has seven items in a submenu: **Delete**, **Edit**, **X-Ray**, **Reports**, **Performance Attribution**, **Send To**, and **Share With**.

**Delete** will remove the selected (check mark in the check box next to the item to be removed) item.

The **Edit** selection will open the *Account* window for the selected account. See page 29 for information about accounts and page 30 for the *Account* window.

**X-Ray** will open the *X-Ray* window. Please go to page 60 for information about the *X-Ray* window.
The Reports selection has four items in a submenu: Portfolio, Performance, Management, and Analytical Reports. Each of these has one or more items in another submenu. Clicking on one of the report selections will open a window with the report displayed.

The Performance Attribution selection of the Action menu has four items under it: Equity Single Attribution, Equity Multiple Attribution, Total Portfolio attribution, and Total Multiple Attribution. These are the same selections that are in the Performance Attribution selection in the New menu in the Morningstar Direct header bar. Please go to page 33 for information about the Performance Attribution menu selection.

The Send To selection will send a selected report to a recipient either inside or outside your firm. The Within My Firm selection will open a Find Users Within My Company window. This window searches for users within the firm. Click on a user and then the OK button to send the report.

The Outside My Firm selection will open a Send Copy To window where you enter the recipient’s e-mail address.

Share With will perform the same functions as the Send To selection.

New

The New selection will open a Morningstar Direct window where you may set up a new group.

Export

The Export selection in the tool bar will export the selected items to Excel. If you do not select any items the Export function will export the Account Groups page.

PDF

The PDF selection in the tool bar will create a PDF report of the selected items. The report will be displayed in a new window in PDF format. If you do not select any items the PDF function will create a report of the Account Groups page.

Refresh

The Refresh selection in the tool bar is used to refresh the data displayed on the Account Groups page.
Securities Invested

The **Securities Invested** selection in the **Portfolio Management** topic opens the **Invested Securities** page. This page lists the securities in which investments have been made.

The list includes the entity name, shares held, market value, current price and more.

Clicking on an entity name will open the **Company** page for that entity. See page 10 for information about the **Company** page.

There is a menu bar with three selections: **Action** (with six items in a submenu), **Export**, and **Refresh**.

Action

The **Action** menu has six selections: **Save As**, **Add To**, **View Holdings**, **Reports**, **Charts**, and **Filing**.

**Save As** has four items in a submenu. This function allows you to save the portfolio as an **Account**, **Investment List**, **Model Portfolio**, or **Custom Benchmark**.

**Add To** has four items in a submenu. This function allows you to add the selected portfolio to an **Account**, **Model Portfolio**, **Investment List**, or **Custom Benchmark**.

The **View Holdings** selection has a submenu with one selection: **Detailed Holding Analysis**. To use the **Detailed Holding Analysis** selection you must have one item in the model portfolio list selected (a check mark in the check box by the item).

The **Detailed Holding Analysis** selection will open a **Morningstar Direct** window with a list of the items in the selected portfolio.

You may export, search the list, and open the list in PDF format. In PDF format you may save, e-mail or print the information.
The **Reports** and **Charts** selection have submenus (with six items in the **Reports** menu and 18 items in the **Charts** menu). These items are similar to and operate in a similar manner as **Reports** and **Charts** in the **Action** menu for the **Model Portfolios** selection in the Portfolio Management topic. See page 89 for information about the **Reports** menu and page 90 for information about the **Charts** menu.

The **Filing** selection will open a window listing all the SEC filings that have been made for the selected entity. Clicking on the icon in the last column will open the document in a new window. The documents are available in PDF or HTM format.

There are about ten years of filings available, depending on the entity selected.

**Export**

The **Export** selection in the tool bar will export the selected items to Excel. If you do not select any items the **Export** function will export the **Securities Invested** page.

**Refresh**

The **Refresh** selection in the tool bar is used to refresh the data displayed on the **Securities Invested** page.
Saved Reports

The Saved Reports selection under the Portfolio Management topic in the Morningstar Direct menu column will open the Saved Reports page.

The Saved Reports page has a header menu bar with four selections: Action (with two items in a sub-menu), Export, Print and Refresh.

Action

The Action menu has two selections: Delete and Assign Folder.

Delete will remove the selected (check mark in the check box next to the item to be removed) item.

Clicking on Assign Folder will open a window with a list of folders from which you may select to put the selected item into. Highlight the folder in the list so that the folder name appears in the Name data field and click on the OK button.

Export

The Export selection in the menu bar will export the Saved Reports page list to Excel. Only the list is exported.

Print

The Print selection in the menu bar will print the Saved Reports page. Only the list is printed.

Refresh

Clicking on Refresh will update the data in the reports with the latest data available.
Portfolio Analysis

The Portfolio Analysis topic area of the menu column has one item under it: Portfolio Analysis. When the Portfolio Analysis topic is selected the Portfolio Analysis page is opened.

This page displays a list of portfolios that have been saved in Morningstar Direct. Clicking on a portfolio’s name will open the analysis of that portfolio in a new window using Internet Explorer. You may have to enter the user name and password (same as that on the Library desktop).

This is an interactive window. Changes in each security’s status is updated continually (about every three seconds). It may take some time for the analysis to finish loading.

Portfolio Analysis Page

The Portfolio Analysis page has a menu bar with three selections: Action (with a menu of two items), New Portfolio, and New Group.

Action

The Action selection has a menu with two items: Rename and Delete.

Rename allows you to change the name of a selected portfolio.

Delete allows you to remove the selected portfolio.
New Portfolio

The New Portfolio selection opens the Select Portfolio window. The Select a Portfolio window is similar to the Find Investments window. See page 19 for information about the operation of the Find Investments window.

After selecting an item from the results box click on the OK button, this will open the analysis of that portfolio in a new window using Internet Explorer.

New Group

The New Group selection opens the New Group window. This window allows you to create a new group. Enter a name into the Name box. Click on the OK button when finished.

The new group will be added to the list of portfolios.
Asset Flows

The **Asset Flows** topic area of the menu column has two selections: **Asset Flows** and ICI Confidential Survey (Investment Company Institute). The display opens with the **Asset Flows** page.

**Asset Flows**

The **Asset Flows** selection displays the **Asset Flows** page with a large amount of fund data. The **Asset Flows** page is Morningstar’s delivery platform for information about the asset management industry. The page has two tabs: **Market Summary** (the default display) and **Workspace**. The page also has six buttons in the header. Each tab has its own selections and buttons in addition to these. The page header buttons are: **Custom Report**, **Search**, **Advanced Search**, **Export**, **Print** and **Help**. The **Export** and **Print** buttons are not included in the **Workspace** tab header. The other buttons perform the same functions in both tabs.

**Market Summary Tab**

The **Market Summary** tab is displayed when the **Fund Flows** selection is first opened. This page has the data displayed in a table. The selections in the header allow you to modify the data being displayed. There are some boxes, with drop-down menus, that you can use to select the data to display. These are **Market**, **Mkt Sh Basis** (Market Share Basis), **Dist Channel** (Distribution Channel—ICI Method of Sale), and **Active/Passive**.
Menu Column—Asset Flows

The top row has the Market box. The Market Note button next to it will display a one-line description of the selected market. The rest of the row allows you to select Monthly or Weekly and has the Effective Date, Currency and the date the financial snapshot was taken.

As selections are made from the Market menu the selections in the second row may change. All three boxes may not be displayed for all selections. Also, the selections in the drop-down menus may change as well depending on the selected market.

As selections are made in the menus the data displayed will change to reflect the settings you have made.

The data is broken down into a variety of groups including Fund Families, Morningstar Categories, Funds, Share Classes and more. The groups vary depending on the selections you have made.

Each group has some links near the bottom of each section. These are Drill Down, View Chart and View All.

Drill Down

The Drill Down link will open a Morningstar Direct window. This window displays the same data that is in the Asset Flows page. The items in the column on the left are the same as the groups displayed in the Asset Flows page (i.e., Fund Families, etc.). Each selection from this column will display that group of data. The data display is of one section of columns of the Asset Flows page. Other data sets may be displayed by selecting the desired data set from the Sub-View drop-down menu in the upper right of the table.

There are four buttons at the bottom of the page: Advanced Search, Export, Print and Close.

The Advanced Search button will open the same Advanced Search function as the Advanced Search button in the Fund Flows header. See page 105 for information about this function.

Export will open the displayed data in an Excel spread sheet.

Print will send the displayed data to a printer.

Close will close the window.

View Chart

The View Chart link will open a chart window of the selected data group. You may change the chart display by making selections from the boxes across the top of the window.

The buttons across the bottom of the window allow you to Export Data to Excel, Print the chart, or Close the window.
View All

The View All link will open a Morningstar Direct window with all the entities in the selected group. Many of the groups on the Asset Flows page only display the top five to ten entities in that category. Selecting the View All link allows you to see the entire list.

The buttons across the bottom of the window allow you to Export the list to Excel, Print the list, Close the window or open a Help window.

Workspace Tab

The Workspace tab opens another display of data. This tab also has the Market box where you may select alternate markets to display.

Each market display includes a chart, lists of any saved searches, new products and other items.

Each section of the tab display has one or more links, including View All, Refresh and Search Last 30 Days.

The Refresh link will update the information displayed to reflect the latest data available.

The View All link will display the complete list of items from that section instead of the top five or ten.

The Search Last 30 Days link will open a new window with a list of the items in that category from the last 30 days.

The Workspace tab has a View Markets Report button in the header. Clicking on this button will open a Market window. This window lists all the market reports available.

Each title is a link that will open the selected report in a new window, similar to the Morningstar Direct window that is opened when the Drill Down link is selected in the Market Summary tab. See page 102 for information about this window.
**Custom Report Button**

The **Custom Report** button in the Asset Flows header will open a *Morningstar Direct* window with a custom report form.

You may name the report and make a variety of selections to customize the report to fit your needs.

After making your selections click on the **Generate Report** button to create your report. You will see a *File Download* window giving you the option to **Save** or **Open** the report. Clicking on **Save** will open a *Save As* window where you are prompted to name the file and select the destination folder.

The **Open** button will open the report in Excel.

The **Clear** button will clear any entries or selections you have made.

**Close** will close the custom report window.

Clicking on the **Save** button will save your report’s set up in the **Custom Report** tab of the **Saved Actions** section on the **Workspace** tab.

The **Save As** button is grayed out until you have either saved the current report or have opened a previously saved report. You may use the **Save As** button to save the existing report under a different name so you may modify the report without affecting the original report.

**Search**

The **Search** button will open two new boxes in the **Asset Flows** page header. The first box has a drop-down menu with more than a dozen selections. You may select one of these items by clicking on it.

Clicking in the second box will display another menu with a long list of selections. The selections vary depending on the selection you made in the first data field.

Clicking on an item in the second menu will start the search and open a *Morningstar Direct* window similar to the window displayed using the **Drill Down** link in the **Fund Flows** page **Market Summary** tab. See page 102 for information about this window.
Advanced Search

The Advanced Search button in the Asset Flows header will open the Advanced Search window.

This window reflects the market that is currently selected on the Market Summary tab (i.e., US Open-End ex MM ex FoF). The selections in the column on the left vary depending on which market is being used.

The boxes on the right (and the available records) vary depending on the item category selected in the column.

The initial display for all the selections is to have all the available records also in the Selected Records box. You must deselect records to modify the search.

The right side has two tabs: Fund Families (or other selection from the column—the tab name changes as different selections in the column are made) and Additional Criteria. The Additional Criteria tab is blank for most of the selections. Only a few (such as Funds and Share Classes) have additional boxes on this tab.

Once you have made your selections click on the OK button to begin the search. This will open the same Morningstar Direct window that is opened when a Drill Down link on the Market Summary tab of the Fund Flows page is selected. Please go to page 102 for information about this window.

The Cancel button will close the Advanced Search window.

Clicking on the Open button will display a window where you may select a previously saved search to open. If none have been saved the list will be blank.

Save will open a window where you may name and save the search. It will be listed on the Workspace tab (of the Fund Flows page) in the Saved Actions section.

The Save As button is grayed out until you have either saved the current search or have opened a previously saved search. You may use the Save As button to save the existing search under a different name so you may modify the search without affecting the original search.

Export

Clicking on the Export button will open a File Download window where you may either Open or Save the data displayed on the Market Summary tab (the Workspace tab does not have the Export button). Save will open a Save As window where you are prompted to name the file and select the destination folder.

The Open button will open the report in Excel.
Print
Clicking on the Print button will open a Print window where you may select the printer to use to print out the data on the Market Summary tab (the Workspace tab does not have the Print button).

Help
The Help button will open a Morningstar Direct window with a help feature. The information is specific to the Fund Flows topic.

ICI Confidential Survey
The ICI Confidential Survey selection opens the ICI (Investment Company Institute) Confidential Survey page. This page is set up to display data in a table. However, the current subscription does not cover this service.

Once data is displayed you would be able to open different sets of data by selecting different sets from the View data field drop-down menu.

The Edit Data button opens the Select Data Points window. You would use this window to select the columns to display in the table. See page 26 for information on using the Select Data Points window.

The Sort button would allow you to sort the data by your selected fields.

Export and Print would export the page to Excel or print it.

The Refresh button would update the data displayed on the page.
Presentation Studio

The Presentation Studio topic area of the menu column has one selection: Presentation Studio. This opens the Presentation Studio page. The Presentation Studio is a feature that helps you create custom reports, slideshows in PDF and PPT format, and other publications.

The Presentation Studio page has a number of active areas. There is a tool bar across the top of the display area. The main body of the display is active and may be used to select charts. There are three tabs across the bottom of the main display.

Tool Bar

The Tool Bar has buttons for Home, Workbook, Factsheet, Plan Review, Asset Allocation, Batch Management and Global Settings. The Home button returns you to the opening page.

Workbook

Workbook will open the Create New Workbook window. This window gives you three choices: New Workbook, Morningstar Templates, and My Templates. The Morningstar Templates and My Templates selections have drop-down menus that are activated when one of them is selected.
New Workbook

Selecting New Workbook and clicking on the OK button will open the Investments: Settings window. This window is used to create your list of companies for the workbook.

You have the option to use a saved list by clicking on the down arrow in the Saved Lists box. This will give you a display of lists that you may use. Select a list by clicking on it. The items in that list will be displayed in the main section of the Investments: Settings window.

You may Add or Delete items from this list. If you do not use a saved list you may construct a new list using the Add button.

Clicking on the Add button will open a Find Investments window. See page 19 for information on the Find Investments window.

You may delete items from the list by clicking on the check box next to the item so that a check mark appears in the box. Then click on the Delete button.

Each item on the list has a check box in the Show column. A check mark in this box ensures the items will be included in your workbook. If you do not want an item to be included in your workbook but do not want to delete it, click on the check box in the Show column. This will hide the item when you create a workbook.

The Investments: Settings window also allows you to display benchmarks. There are two already identified in the Benchmark data field. You may display one or both of these by clicking on the check box in the Show column or you may select a different benchmark.

To select a new benchmark click on the Search icon in the row of the benchmark you wish to replace. This will open the Select Benchmark window. This window is similar to and operates in a similar manner as the Find Investments window. See page 19 for information about the Find Investments window. Once you have found a new benchmark it will replace the one in the selected row.

The Category Average box allows you to display the average for the workbook you are creating. You may select a different item for this by clicking on the Search icon. This will open the Select Benchmark window. This window is similar to and operates in a similar manner as the Find Investments window. See page 19 for information about the Find Investments window.

All boxes have selection menus (visible after scrolling the data fields to the right) that allow you to select the color of the item and the symbol for the item when they appear on a chart.

When you have finished setting up your workbook click on the OK button.
This will open the Morningstar Presentation Studio window. The work area of the window will be blank, waiting for you to begin designing your presentation. This is the feature used to fully set up your presentation. See page 118 for information about the Morningstar Presentation Studio window.

Morningstar Templates

Selecting Morningstar Templates activates the drop-down menu for that item. Select the template you want by clicking on it and then on the OK button. This will open the Investments: Settings window. This window is the same window that is opened when you select New Workbook. See page 108 for information about the Investments: Settings window. Once you have selected the list you want to use click on the OK button to open the Morningstar Presentation Studio. The studio work area will have the template you selected in the Create New Workbook window. See page 118 for information about the Morningstar Presentation Studio window.

My Templates

Selecting My Templates activates the drop-down menu for that item. If no workbooks have been saved the menu will be blank. If there are templates to use, select one and continue to set up your list as in the Morningstar Templates selection, see above.

Factsheet

Factsheet will open the Create New Factsheet window. This window gives you three choices: New Factsheet, Morningstar Templates, and My Templates. The Morningstar Templates and My Templates selections have drop-down menus that are activated when one of them is selected.
New Factsheet

Selecting New Factsheet and clicking on the OK button will open the Investments: Settings window. This window is used to select your entity for the factsheet. This version of the window (similar to but having significant differences from the Investments: Settings window opened in the Create New Workbook window) allows you to select only one entity for your factsheet.

You have the option to show up to two benchmarks and one category average on your factsheet. You may show these items by clicking on the check box in the Show column.

You may select different benchmarks by clicking on the Search icon in the row of the item to be replaced. This will open the Select Benchmark window. This window is similar to and operates in a similar manner as the Find Investments window. See page 19 for information about the Find Investments window. Once you have found a new benchmark it will replace the one in the selected row.

To select an entity for your factsheet, click on the Search icon in the top section of the window. This will open the Find Investments window. See page 19 for information on the Find Investments window. Only one item may be listed in the top section. If another item is searched, it will replace the original item.

All boxes have selection menus (visible after scrolling the data fields to the right) that allow you to select the color of the item and the symbol for the item when they appear on a chart.

When you have finished setting up your workbook click on the OK button.

This will open the Morningstar Presentation Studio window. The work area of the window will be blank, waiting for you to begin designing your presentation. See page 118 for information about the Morningstar Presentation Studio window.

Morningstar Templates

Selecting Morningstar Templates activates the drop-down menu for that item. Select the template you want by clicking on it and then on the OK button. This will open the Investments: Settings window.

This window is the same window that is opened when you select New Factsheet. See above for information about the Investments: Settings window. Once you have selected the entity you want to use click on the OK button to open the Morningstar Presentation Studio. The studio work area will have the template you selected in the Create New Factsheet window. See page 118 for information about the Morningstar Presentation Studio window.

My Templates

Selecting Saved Factsheet Templates activates the drop-down menu for that item. If no factsheets have been saved the menu will be blank. If there are templates to use, select one and continue to set up your list as in the Morningstar Templates selection, see above.
Plan Review

Plan Review will open the Create New Plan Review window. This window gives you three choices: New Workbook, Morningstar Templates, and My Templates.

New Plan Review

Selecting New Plan review and clicking on the OK button will open the New Plan Review window. You must select a plan to continue but there are no plans available at the time of writing.

Morningstar Templates and My Templates

The Morningstar Templates and My Templates selections do not have any items available at the time of writing.

Asset Allocation

Asset Allocation will open the Create New Report window. This window gives you three choices: New Report, Morningstar Templates, and My Templates.

All three selections do not have any items available at the time of writing.

Batch Management

Batch Management will open the Batch Reporting window. This window has two tabs: Batch Management and Batch Reports.

Batch Management Tab

The Batch Management tab is displayed when the window is first opened. This tab has an Action menu with seven items, a drop-down menu with five items, and five buttons: Run Now, Schedule, New Batch, Template Mapping, and Refresh.

Action

The Action selection in the Batch Management tab menu bar has seven selections: Schedule, Delete, Save As, Rename, Cancel Running Batch, Clear Schedule, and Rerun Failed Reports.

Schedule will open the Schedule window for the selected file. This window is used to set up a run for the selected batch. You may set up a one-time run or a recurring schedule of runs. After setting up your schedule click on the OK button. This will close the window and return you to the Batch Reporting window.
Delete will remove any selected batches.

Save As allows you to save a selected batch file under a new name.

Rename allows you to rename the selected batch file.

Cancel Running Batch will cancel any batch runs that have been initiated.

Clear Schedule will remove any scheduling from the selected batch file.

Rerun FailedReports will cause any failed runs to be run again.

Drop-Down Menu

The Type data field has a menu with five selections: All, Factsheet, Workbook, Saved Files, and Retirement Plan. Selecting one of these will display only those items in the Batch Management tab list.

Run Now

The Run Now button will process a run on the selected batch. This may take a few minutes as the request is placed in a queue and then must be run when its turn comes up.

After the run the batch is marked in the Status column as having been processed.

Schedule

The Schedule button will open the Schedule window for the selected file. See page 111 for information about the Schedule window.

New Batch

If no batches have been created there is no list. To populate the list click on the New Batch button.

This will open the New Batch Setup window. In this window you may select the type of batch you want to create. The choices are: Factsheet, Workbook, Retirement Plan, or Saved Reports. Select your option by clicking on the radio button and click on the Continue button.

Factsheet

For the Factsheet selection, a secondary New Batch Setup window will be opened. This window has two selections: Use a Single Template and Use Multiple Templates. Select your option by clicking on the radio button and click on the Continue button.

The Factsheet - New Batch Setup window will be opened. This window is used to setup a new batch file.

You may name the new file, select a template, and select a list or search. Selecting a list or search will enter the items in that list or search to the main box. A maximum of 25 items may be added. Also, if another list or search is selected it new list will replace
the first list you selected.

Additional items may be added to the list by clicking on the Add button near the top of the list. This will open the Find Security window. Use this window to search for and select items to add to your list. Click on the OK button when you have made your selections.

Items may be removed from the list by selecting them and clicking on the Delete button.

The Advanced Settings button at the bottom of the Factsheet - New Batch Setup window will open the Advanced Settings window. This window gives you more options to fine tune your selections.

When you have finished setting up your new batch file you may either Save it or Schedule it to run by clicking on the appropriate button.

Workbook

For the Workbook selection, the Workbook - New Batch Setup window will be opened. This window is used to setup a new batch file.

You may name the new file and select a template. Items may be added to the list by clicking on the Add button near the top of the list. This will open the Find Security window. Use this window to search for and select items to add to your list. Click on the OK button when you have made your selections.

Items may be removed from the list by selecting them and clicking on the Delete button.

The Advanced Settings button at the bottom of the Workbook - New Batch Setup window will open the Advanced Settings window. This window gives you more options to fine tune your selections.

When you have finished setting up your new batch file you may either Save it or Schedule it to run by clicking on the appropriate button.

Retirement Plan

For the Retirement Plan selection, the New Batch Setup window is opened. This window gives you two selections: Plan Books and Plan Factsheets Only. Select your option by clicking on the radio button and click on the Continue button.
This will open the *Retirement Plan - New Batch Setup* window. This window is used to setup a new batch file.

You may name the new file, select a template and template mapping.

The **Add** button will open the Select Retirement Plans window.

At the time of this writing there are no retirement plans available.

**Saved Reports**

For the Saved Reports selection, the *Selected Reports* window will be opened. There are currently no reports available.

**Template Mapping**

The **Template Mapping** button will open the Template Mapping window. This window has an **Action** menu with three items and a **New Mapping** button.

The **Action** menu has selections for **Delete**, **Rename** and **Save As**.

**Delete** will remove any selected batches.

**Save As** allows you to save a selected batch file under a new name.

**Rename** allows you to rename the selected batch file.

The **New Mapping** button will open the *New Template Mapping* window. This window allows you to select a mapping data point from a drop-down menu. Once you have made your selection click on the **Continue** button.

This will open the *Template Mapping* window. This window lists the items in the template you selected and allows you to name the new template. Click on the **Save** button when you have finished.

**Refresh**

The **Refresh** button will update the information displayed in the **Batch Management** tab of the *Batch Reporting* window.
Batch Reports Tab

The **Batch Reports** tab has four tabs: *Retirement Plan*, *Factsheet*, *Workbook*, and *Saved Reports*.

Each tab lists the files included in each category. If there are no files the list is blank.

The Retirement Plans and Factsheet tabs have Browse By menus that allow you to display only the files for that selection.

There is also a search feature that allows you to search for files if the list is very long.

Global Settings

The **Global settings** button will open the *Application Settings* window. This window allows you to customize the settings for the various elements used in the *Morningstar Presentation Studio*.

The *Application Settings* window has six tabs: *Data*, *Attribution*, *Layout*, *Peer Group*, *Display*, and *Grouping*.

Each tab has numerous settings that you may use to modify the displays to fit your needs. When you have finished making your settings click on the **OK** button to exit the window.
Display Area

The Display Area is an active screen where you may select a chart to set up.

There are seven charts that you may select from this section of the page. These are Trailing Returns, Performance Relative to Peer Group, Investment Growth, Holdings Based Style, Risk-Reward, Returns Based Style History and Weighting Effects.

The buttons on each side of the Display Area allow you to scroll through the various charts. The small buttons near the bottom center of the Display Area allow you to go directly to a chart.

Once a chart is displayed, you may access that chart by clicking on the Launch Chart button. This will open the Investments: Settings window. This is the same window that is opened in the Workbook button from the Tool Bar. See page 108 for information about the Investments: Settings window.

Once you have made your selections, click on the OK button. This will open the Morningstar Presentation Studio window. See page 118 for information about the Morningstar Presentation Studio window.
Tabs and Button Bar

The **Tabs and Button Bar** near the bottom of the display area has three tabs and two buttons. The tabs are **Morningstar Templates**, **My Templates**, and **Reports**. The buttons are **Actions** and **New Folder**.

**Morningstar Templates Tab**

The **Morningstar Templates** tab will display a list of templates that are available. These are the same templates that are listed in the **Morningstar Templates** menus in the **Create New Workbook** and **Create New Factsheet** windows.

Double-clicking on a template name will open the **Investments: Settings** window. This is the same **Investments: Settings** window that is opened when the **New Workbook** selection is used in the **Create New Workbook** window. See page 108 for information about the **Investments: Settings** window.

Once you have created your list in the **Investments: Settings** window the template you selected will be opened in the **Morningstar Presentation Studio** window when you click on the **OK** button.

**My Templates Tab** and **Reports Tab**

The **My Templates** tab and **Reports** tab will display lists of saved files, if any have been saved. Files that are saved in the **Morningstar Presentation Studio** window will show up on this list. Each line has a check box that you may use to select it. These are used in conjunction with the **Actions** button. Select a line and then select the action to take on it. See below for information about the **Actions** button.

**Actions Button**

The **Actions** button will display a menu with five selections: **Delete**, **Save as Template**, **Send To**, **Share With**, and **Refresh Landing Screen**. These selections will only work with items in the **My Templates** and **Reports** tabs. You may delete a folder by selecting it and clicking on the **Delete** selection.

The other selections will only work if you are the owner of the folder.

**New Folder Button**

The **New Folder** button will add a new folder to the **My Templates** and **Reports** tabs (the tab must be open). You may rename the folder by right-clicking on it and selecting **Rename** from the content (right-click) menu.
Morningstar Presentation Studio Window

The *Morningstar Presentation Studio* window is opened when you have finished setting up your criteria in the *Presentation Studio* page. See page 107 for information on setting up the criteria.

The initial display is different for the various methods of opening the Presentation Studio. Using the **Workbook** or **Factsheet** selections will display a blank work area. You then use the controls in the *Morningstar Presentation Studio* window to select the various charts and tables to display the data you need.

Selecting a chart from the main display area and using the **Launch Chart** button will open the *Morningstar Presentation Studio* window with your selected chart displayed.

Using a selection from the **Morningstar Templates** tab will open the *Morningstar Presentation Studio* window with the template displaying the data you selected.

The *Morningstar Presentation Studio* window is broken up into a header, the display area with a page menu column on the left, and a row of controls across the bottom of the screen.
Header

The *Morningstar Presentation Studio* window header has four tabs and five buttons.

Buttons

The buttons are the **Morningstar** button on the left side of the page, and the **Cut**, **Copy**, **Paste** and **Delete** buttons on the right side of the page. The **Cut**, **Copy**, **Paste** and **Delete** buttons will perform the indicated actions on a page or component you have selected by clicking on it or highlighting it.

The **Morningstar** button displays a menu with nine selections: **New Workbook**, **Open**, **Save**, **Save As**, **Save As Template**, **Export**, **Send To**, **Share With**, and **Exit**.

The **New Workbook** selection will open the *Create New Workbook* window. This is the same window that is opened when **Workbook** is selected on the *Presentation Studio* page. See page 107 for information about the *Create New Workbook* window.

**Open** will open the *Saved Workbooks* window. This window lists all saved worksheets, if any. Select one from the list and click on the **Open** button.

**Save** will open the *Saved Workbooks* window with a box to enter a name. Enter a name for the workbook into the **Workbook Name** box and click on the **Save** button.

**Save As** will open the *Saved Workbooks* window and allow you to save the workbook under a new name. Click on the **Save** button when you have entered a new name.

**Save As Template** will open the *Saved Templates* window, allowing you to save the file as a template after entering a name into the **Template Name** box.

**Export** will open the file in PDF format in a new window using Adobe Reader.

The **Send To** selection will send the workbook to a recipient either inside or outside your firm. The **Within My Firm** selection will open will open a *Find Users Within My Company* window. This window searches for users within the firm. Click on a user and then the **OK** button to send the report.

The **Outside My Firm** selection will open a *Send Copy To* window where you enter the recipient’s e-mail address.

The **Share With** selection is similar to **Send To** and has the same selections. The Share With selections allow you to share access to your items with another person.

**Exit** will close the *Morningstar Presentation Studio* window.
Tabs

The *Morningstar Presentation Studio* window header has four tabs: **Home, Chart, Data Table** and **Format**.

Home Tab

The **Home** tab has selections in six categories: **Setting, Insert, Layout, Calculate, Linking,** and **Export**.

The **Setting** category has two items in it: **Investments** and **Workbook**. Each of these will open a new window.

The **Investments** selection will open a window similar to the *Investments: Settings* window. This is the same window that is opened when **New Blank Workbook** is selected on the *Presentation Studio* page. Please go to page 108 for information about the *Investments: Settings* window.

You may use this window to adjust the settings for the workbook you currently have open.

The **Workbook** selection will open the *Workbook Settings: Data* window. This window has five tabs with settings that allow you to adjust the look and data of the workbook currently open. The tabs are: **Data, Layout, Style, Peer Group,** and **Attribution**.

The **Data** tab has settings to adjust the time period, data source and the portfolio data as of date. Most boxes have drop-down menus that offer you a variety of choices for each item. The **Risk-Free Rate** box has a search icon that will open the *Select Benchmark* window. This window is similar to the *Find Investments* window. See page 19 for information about the *Find Investments* window.

The **Layout** tab has selections to adjust the font style, font size and font color.
The **Style** tab has items to adjust the constraints, confidence region, and style indexes. The Style Indexes selections have search icons that will open the *Select Benchmark* window. This window is similar to the *Find Investments* window. See page 19 for information about the *Find Investments* window.

The **Peer Group** tab has items to adjust the universe and category of the entities the program selects as the peer group. You also have the option to select a user defined list.

The **Attribution** tab has items to adjust the time period, attribution and classification attributes of the workbook currently open.

Once you have finished making your selections click on the **OK** button at the bottom of the window to have your adjustments take effect.

The **Insert** category of the page header has five items: **Page**, **Chart**, **Table**, **Text**, and **Image**.

The **Page** selection opens a menu with four items: **New**, **Cover**, **Duplicate**, and **Delete**. The **New** selection will insert a blank page after the current page.

The **Cover** selection will insert a blank cover page before the first page.

The **Duplicate** selection will insert a copy of the current page after the current page.

**Delete** will delete the current page.

The **Chart** selection has six items on a menu: **Multiple Investments**, **Single Investment**, **Equity Attribution**, **Multiple Returns**, **All Charts**, and **My Components**.

Each of these selections will display a window with selections of various charts that are available within that selection. The charts for **Multiple Investments** is pictured.

A chart may be used by clicking on it and dragging it to the page that is open in the Presentation Studio.

Dragging other selections to the same page will replace any item already displayed. If a new item is desired, open a new page using the **Page** selection.
Once a chart has been positioned on the page a menu appears in the bottom of the display area. For a chart the menu is Chart Settings. This menu may be used to modify the way the chart is displayed and the time period of the chart.

The Table selection has six items on a menu: Multiple Investments, Single Investment, Equity Attribution, Multiple Returns, All Tables, and My Components. The operation of this selection is the same as for Charts. Once a table is positioned on a page a Table Settings menu appears at the bottom of the display area. This menu may be used to modify the way the table is displayed and the time period of the table.

The Text selection has a menu with eight items: Custom Text, Dynamic Text, Investment Strategy, Manager Biography, Manager Narratives, Morningstar Commentary, Note, and Principal Risk. Each of these will insert a text box into the workbook.

Some of the selections will insert a predefined block of text into the box, others will insert a blank box so you may enter your own text into the workbook.

The Image selection will open an Open window so that you may select an image to place into the workbook. Select the image you want and click on the Open button.

The Layout category of the page header has one selection: Divide Layout. This will open a menu display with a variety of page layouts you may select. The various layouts will divide a page into cells in varying arrangements, from two cells to a page up to six cells to a page.

Click on the image of the cell layout you want to select for the workbook.

You may subdivide areas of the page. For instance, if you have divided the page into two halves (top and bottom) you may then select the bottom half and divide it into three more cells by selecting a three-cell layout.

The Calculate category of the page header has one item: Calculate. This will display a menu with two selections: Workbook and Selected Component. Workbook will update the data in the entire workbook with the latest information.

The Selected Component selection will update the data in the highlighted component.

The Linking category has one item: Restore. This selection is not active.

The Export category of the page header has three items: PDF, PPT and XPS. Each of these will display a menu with three selections: Workbook, Selected Page(s), and Selected Component. This allows you to export the specific material you want.
Clicking on a selection will open that selection in the desired format. For example, **Workbook** in the **PDF** selection will open the entire workbook in PDF format in Adobe Reader. Highlighting a number of pages (hold down the **Control** [Ctrl] key while clicking on pages in the page menu column of the display area) and the **Selected Page(s)** selection will display those pages in Adobe Reader. The same is true for the **Selected Component** selection. (Only one component may be exported at a time.)

The **PPT** selections will open the desired pages in PowerPoint.

The **XPS** selections will open the desired pages using a XPS viewer.

**Chart Tab**

The **Chart** tab of the page header has selections in eight categories: **Investments**, **Time Period**, **Chart Area**, **Axis**, **Layout**, **Calculate**, **Linking**, and **Export**. The **Chart** tab is opened when a chart is selected in the workbook.

![Chart Tab Selections](image)

The **Investment** category has one item in it: **Investments**. This will open a window similar to the **Investments: Settings** window. See page 108 for information about the **Investments: Settings** window.

The **Time Period** category has three items in it: **Start Date**, **End Date**, and **Rolling Window**.

- The **Start Date** and **End Date** selections have drop-down menus so you may select settings from the list. The **Rolling Window** selection will activate the rolling window function and add points to specific charts (not all charts will accept the rolling window function). The **Rolling Window** calculates rolling statistics, where the start date and end date both move forward together. Rolling windows are typically used to measure consistency of data.

The **Chart Area** category has one item: **Align**.

- The **Align** selection has a menu with six selections: **Left**, **Middle**, **Right** and **Top**, **Middle**, **Bottom**. These selections will align the text in selected boxes to the margin indicated (left, right, etc.).

- The other controls in this category allow you to select a font style from a drop-down menu, the font size from another drop-down menu and toggle Bold, Italic and Underline on and off for the selected text box.

The **Axis** category of the page header has two buttons. The left button will add numbers after the decimal point, while the button on the right will remove numbers after the decimal point.

The **Layout**, **Calculate**, **Linking**, and **Export** categories are the same as and perform similarly as the same categories in the **Home** tab. See page 122 for information about these categories.
Data Table Tab

The **Data Table** tab has selections in seven categories: **Investments**, **Time Period**, **Format**, **Layout**, **Calculate**, **Linking**, and **Export**. The **Data Table** tab is opened when a table is selected in the workbook.

The **Investment** category has one item in it: **Investments**. This will open a window similar to the **Investments: Settings** window. See page 108 for information about the **Investments: Settings** window.

The **Time Period** category has three items in it: **Start Date**, **End Date**, and **Rolling Window**. The **Start Date** and **End Date** selections have drop-down menus so you may select settings from the list. The **Rolling Window** calculates rolling statistics, where the start date and end date both move forward together. Rolling windows are typically used to measure consistency of data.

The **Format** category has four items: **Grid**, **Align**, **Decimal**, and some font controls.

   - The **Grid** selection has nine items: **All**, **Middle Horizontals**, **Middle Verticals**, **Inside Borders**, **Outside Edges**, **Left Edge**, **Right Edge**, **Bottom Edge**, and **None**. Each of these selections will display the selected grid lines in the highlighted table.

   - The **Align** selection has a menu with six selections: **Left**, **Middle**, **Right** and **Top**, **Middle**, **Bottom**. These selections will align the text in selected boxes to the margin indicated (left, right, etc.).

   - The other controls in this category allow you to select a font style from a drop-down menu, the font size from another drop-down menu and toggle Bold, Italic and Underline on and off for the selected text box.

   - The **Decimal** category has two buttons. The left button will add numbers after the decimal point, while the button on the right will remove numbers after the decimal point.

The **Layout**, **Calculate**, **Linking**, and **Export** categories are the same as and perform similarly as the same categories in the **Home** tab. See page 122 for information about these categories.
Format Tab

The **Format** tab has selections in five categories: **Insert, Style, Layout, Linking, and Export.**

The **Insert** category has four items: **Header, Footer, Text, and Image.**

  - The **Header** and **Footer** selections open the **Page Header** or **Page Footer** window where you may select the style of header or footer you want to use. Click on the style you want and it will be applied to the current page.

  Once a header or footer style is selected it will appear on the page. You then double click on the **Enter Text** words on the page so that a menu appears. You may select what to have shown (i.e., page number, date, etc.)

  - The **Text** selection will open the same menu as the **Text** selection in the **Insert** category of the **Home** tab. See page 122 for information about the **Text** selection.

  - The **Image** selection will open an **Open** window so that you may select an image to place into the workbook. Select the image you want and click on the **Open** button.

The **Style** category has three items: **Align, Bullets, Numbering,** and some other controls. The **Align** selection will become active when the page title is selected.

  - The **Align** selection has a menu with six selections: **Left, Middle, Right** and **Top, Middle, Bottom.** These selections will align the text in selected boxes to the margin indicated (left, right, etc.).

  - The **Bullets** and **Numbering** selections allow you to apply bullet symbols or numbers to items on a list.

  The other controls in this category allow you to select a font style from a drop-down menu, the font size from another drop-down menu and toggle Bold, Italic and Underline on and off for the selected text box.

The **Layout, Linking, and Export** categories are the same as and perform similarly as the same category in the **Home** tab. See page 122 for information about the **Export** category.
Display Area

The Morningstar Presentation Studio window’s display area is where the workbook, factsheet or charts are displayed. There are three main sections: the page menu column on the left, the work area where the actual production item is displayed, and a control area across the bottom.

Page Menu Column

The page menu column on the left side of the page has a graphic icon of each page in the workbook. You may navigate from page to page by clicking on the icon of the page you want to view. This menu is also used to select pages for other functions, such as the export function. More than one page may be exported by holding down the Control [Ctrl] key while clicking on the pages you want to export.

Work Area

The work area is the large display in the middle of the page where your document/workbook is displayed. You may highlight the various components of the current page by clicking on the image. As you click on the various components a menu is displayed at the bottom of the display area. This menu changes from Chart Settings to Table Settings depending on which type of component you have selected. See page 121 for information about Charts and page 122 for information about Tables.
Controls

The *Morningstar Presentation Studio* window’s row of controls across the bottom of the screen include a menu in the bottom of the display area that is opened by clicking on the up arrow, a row of tools across the middle of the row and a size slider on the right.

Menu

The menu on the left side of the page has nine selections: *Multiple Investments*, *Single Investment*, *Equity Attribution*, *Fund Flows*, *Multiple Returns*, *All Charts*, *All Tables*, *All Components*, and *My Components*. You may use these selections to control what tools are displayed in the middle section of the row.

The *Multiple Investment* and *Single Investment* selections change the tables from a single investment display to a multiple investment display. The table icons are similar except that the single investment icons are plain while the multiple investment icons have three dots.

The other selections will display the only tools that pertain to the selected topic. (i.e., *All Charts* will change the row of tools to display only the tools for charts and *All Tables* will change the row of tools to display only the tools for tables.)

Tool Bar

If the number of tools being displayed is more than can be displayed at one time, the tool bar may be scrolled from side to side by using the left and right arrows at the sides of the tool bar.

The tool bar displays all the charts and tables that are available for use in your workbook (or factsheet, etc.). As you move your mouse pointer over the row of tools the tools are enlarged and a window appears over the largest tool. The window gives the title of the table or chart and the various components of the item.

To select a chart or table, click and hold the mouse button on the tool and slide it to the position on the page you want it located. Release the mouse button and the selected chart or table will appear on the page, fully populated with data.

Size Slider

The right side of the tool bar has a tool you may use to adjust the size of the page being displayed. The white field gives you the percentage of the size (i.e., 92%). The slider may be slid from side to side to enlarge or reduce the page. You also may click on the plus and minus signs to change the size one percentage point at a time.
Workspace

The **Workspace** topic area of the menu column has ten selections: Investment Lists, Search Criteria, Report Templates, Chart Templates, Data Sets, Custom Database, Saved Reports, Note Manager, Retirement Plans, and Group Manager. The topic opens with My Lists under the Investment Lists selection displayed.

Investment Lists

The **Investment Lists** selection has two items in it: My Lists and Sample Investment Lists. The My Lists page is displayed when the Workspace topic is first opened.

My Lists

The My Lists page has a listing of all the lists that have been saved by the various users of the Morningstar Direct program. There may be submenus of lists that users have created. These lists will be formatted the same as the main list under My Lists.

This page has a header with a menu bar with five selections: Action (with six items in a submenu), New, Export, PDF, and Refresh.

Action

The Action selection menu has six items: Edit (with one item in a submenu: Delete), Share With, Rename, Save As, Send To, and Assign to Folder.

Delete will delete any selected list.

Rename allows you to rename any selected list.

Save As will prompt you to save a selected list with new name. It will then be added to the My Lists page. The list with the original name will remain on the list.

The Send To selection will send a selected list to a recipient either inside or outside your firm. The **Within My Firm** selection will open will open a Find Users Within My Company window. This window searches for users within the firm. Click on a user and then the OK button to send the list.

The **Outside My Firm** selection will open a Send Copy To window where you enter the recipient’s e-mail address.
Clicking on **Assign to Folder** will open a window with a list of folders from which you may select a folder to put the selected portfolio into. Highlight the folder in the list so that the folder name appears in the **Name** data field and click on the **OK** button.

**New**

The **New** menu selection will open a **Select Investments** window. See page 18 for information about the **Select Investments** window.

**Export**

The **Export** selection in the menu bar will export the **My Lists** page list to Excel. Only the list is exported.

**PDF**

The **PDF** selection will display the information in the **My Lists** page in PDF format. Only the list is displayed, not the data in the lists.

**Refresh**

Clicking on **Refresh** will update the data in the lists with the latest data available.

**My Lists Page**

Double clicking on a name in the list will open that list’s page. This list is in a table format with more than 50 columns. Double clicking on a company name will open the **Company** page (see page 10) for that company. An item on the list is selected by clicking on the check box in the item’s row.

This page has a header with a menu bar with 14 selections: **Action** (with 17 items in a submenu), four up and down arrows, **View** menu, **Save**, **Add**, **Edit Data**, **Sort**, **Locate**, **Export**, **PDF**, and **Refresh**.

**Action**

The **Action** menu has 17 items on it: **Save As** (with five selections on a submenu), **Add To** (with four selections on a submenu), **Move To**, **Delete**, **Settings** (with four selections on a submenu), **Reports** (with more than 20 selections on a submenu), **Charts** (with 18 selections on a submenu), **View Holdings** (with four selections on a submenu), **View Owners** (with two selections on a submenu), **Performance Attribution** (with four selections on a submenu), **Portfolio Analysis**, **Average Detail Report**, **Stock Intersection**, **X-Ray**, **Filing**, **SA Documents**, and **News Search**.

**Save As**

The **Save As** menu item has five selections under it: **Custom Benchmark**, **Model Portfolio**, **Investment List**, **Account**, and **Performance Report**. Using one of these selections will save the selected entities (entities are selected by clicking on
the check boxes next to each entity) in the form selected.

Add To
The Add To menu item has four selections under it: Custom Benchmark, Investment List, Model Portfolio, and Account. Using one of these selections will add the selected entities to an existing list. After clicking on your menu selection a list of existing items (i.e., accounts or investment lists) will be displayed. Select the one to which you want to add your current selections and click on the OK button. You will then be prompted to make data selections for the list. Click on the Finish button to complete the action.

You may check the new item by going to the area of the program concerning the type of item modified (i.e., Investment List in the Investment List selection under the Workspace topic of the menu column).

Move To
The Move To menu item will open the Move To window. This window is used to change the position of the selected item on the list to a new location on the list. You have the options of moving it to the First Row, Last Row, or selecting a specific row.

Click on the OK button to enact your changes.

Delete
The Delete selection will delete any items on the list that you have selected by clicking on the check boxes of the items.

Settings
The Settings menu item has four selections under it: Hide Benchmark, Select Benchmark, Show Average, and Select Default Currency. These selections allow you to hide a benchmark (if one has been selected—if one has it will be listed on the first line of the table), select a benchmark, show (or hide) an average (if the average is being shown it will be on the first line of the table), or select the currency to use in the table.

Reports
These selections will open the report window (see page 11) for the type of report selected. Some will open a Report Settings window first so that you may fine tune the report you are generating.

Each Report Settings screen is tailored to the individual Reports selection. The Holdings-Based Style Consistency (HB Style Consistency selection) screen is pictured.

The Quicktake selection will open the Company page for the entity selected. See page 10 for information about the Company page.

The Fund Vs. Fund selection will open the Fund vs. Fund window. This window allows you to compare two funds side by side. You may switch the order of the funds or view the report in PDF format.

Charts

The Charts menu item has 18 selections. These selections will open a chart in a new window displaying the information requested.

View Holdings

The View Holdings menu items has a submenu with four selections: Top Ten Holding Analysis, Detailed Holding Analysis, Historical Holding Analysis, and Peer Holding Analysis.

To use the Top Ten Holding Analysis, Detailed Holding Analysis, and the Historical Holding Analysis selections you must have one item in the list selected (a check mark in the check box by the item). More than one item being checked will open a message window telling you to select only one item.

These selections will open a Morningstar Direct window with a list of the items in the selected entity (i.e., index, portfolio, etc.).

You may export, search the list, and open the list in PDF format. In PDF format you may save, e-mail or print the information.

The Peer Holding Analysis selection allows you to select more than one item from the list at a time. The Morningstar Direct window that is opened compares the holdings of the selected entities.
View Owners

The View Owners menu item has two selections: Detailed Owner Analysis and Peer Owner Analysis.

To use the Detailed Owner Analysis selection you must have one item in the list selected (a check mark in the check box by the item). More than one item being checked will open a message window telling you to select only one item.

The Detailed Owner Analysis selection will open a Morningstar Direct window with a list of the owners of the selected item’s stock.

You may export, search the list, and open the list in PDF format. In PDF format you may save, e-mail or print the information.

The Peer Owner Analysis selection will open the selected items in a new Morningstar Direct window. Information about each item selected will be displayed in a separate column.

Performance Attribution

The Performance Attribution item has four selections: Equity Single Attribution, Equity Multiple Attribution, Total Portfolio attribution, and Total Multiple Attribution. The Equity Single Attribution and Total Portfolio Attribution selections will open the New Report window. See page 33 for information about the New Report window. Upon completing this process a report will be displayed in the Performance Attribution Window. See page 35 for information about the Performance Attribution Window.

The Equity Multiple Attribution and Total Multiple Attribution selections will open a Group Settings window. See page 69 for information about the Group Settings window. Upon completion of this process the report will be sent to the Multiple Portfolios selection under Equity Attribution in the Performance Attribution topic of the program’s menu column. See page 68 for information about the Multiple Portfolios selection.

Portfolio Analysis

The Portfolio Analysis selection will open a Select Portfolio page using Internet Explorer. The selected item from the Workspace Lists page is entered in the Available Records box.

Clicking on the OK button will open a detailed analysis in an Internet Explorer window. See page 99 for information about this window.
Average Detail Report

The **Average Detail Report** item will open a report in PDF format in a new window. This report will be on the average of however many items you selected (a check mark in the check box by each item). This report may be saved, printed or e-mailed from the new window.

Stock Intersection

The **Stock Intersection** item will open a *Stock Intersection* window. This window will display a table of information covering each item selected (a check mark in the check box next to each item in the universe list). This list may be exported or displayed in PDF format in a new window.

X-Ray

The **X-Ray** item will open an *X-Ray* window. This window displays a report that includes all the items you had selected from the list.

The *X-Ray* window has four tabs: **Asset Allocation**, **Stock Sectors**, **World Regions**, and **Top Stock Holdings**. Each tab gives you a broad view of the selected items.

You can display the report in PDF format by clicking on the PDF Report in the page header.

Filing

The **Filing** selection will open a window with a list of filings made by the company. The icons in the last column are links that will open the selected document in a new window.

SA Documents

The **SA Documents** item will open a new window with a listing of documents pertaining to your selection.

News Search

The **News Search** selection will only work with UK listed closed end funds.

Up and Down Arrows

The Up and Down arrow selections allow you to move the selected item up or down the list. The double arrows will move the item to the top or bottom of the list. The single arrows will move the item up or down the list one line at a time.

View

The **View** drop-down menu has numerous selections. Each selection will display a different aspect of the list.

Selecting an item from the menu will change the data columns to display data pertinent to the selected topic (i.e., **Operations**).
Menu Column—Workspace: Investment Lists

Save

The **Save** selection in the list page tool bar will save the current list as it is displayed. Any changes you may have made will be included.

Add

The **Add** button will open the *Select Investments* window. You may use this window to add an item to the list. See page 18 for information about the *Select Investments* window.

Edit Data

The **Edit Data** selection in the tool bar will open the *Select Data Points* window. You may use this window to change the general or calculation settings of the data points you select.

See page 26 for information about the *Select Data Points* window.

Sort

The **Sort** selection in the tool bar will open a window where you may set up the primary and secondary ranking for the universe. Click on the **OK** button when you have finished making your selections.

Locate

The **Locate** selection in the tool bar will open the *Select an Investment* window. This window opens with all the items on the list included in the box in the main part of the window. You may select an item from the list or you may search by typing a term into the **Jump to Record Name** data field. The list scrolls as you enter characters. Once you have located an item, highlight it and click on the **OK** button.

Export

The **Export** selection in the tool bar will export the selected items to Excel. Only the information displayed on the list page will be exported.

PDF

The **PDF** selection in the tool bar will create a PDF report of the selected items. The report will be displayed in a new window in PDF format. Only the information displayed on the list page will be included in the report.

Refresh

The **Refresh** selection in the tool bar is used to refresh the data displayed on the list page. If any data had been updated while you were looking at the page the new data will be displayed after the **Refresh** action is completed.
Sample Investment Lists

The *Sample Investment Lists* page has a listing of any sample investment lists that may be included with the program. At the current time the list is blank.

This page has a header with a menu bar with five selections: **Action** (with six items in a sub-menu), **New**, **Export**, **PDF**, and **Refresh**. This is similar to the *My Lists* page, see page 128 for information about the page header.

Search Criteria

The **Search Criteria** selection has two items in it: **My Search Criteria** and **Sample Search Criteria**. The *My Search Criteria* page is displayed when the **Search Criteria** topic is first opened.

**My Search Criteria**

This page lists any searches that may have been saved.

This page has a header with a menu bar with five selections: **Action** (with five items in a submenu), **New**, **Export**, **PDF**, and **Refresh**. These are similar to the selections in the *My Lists* page (see page 128), except for the **New** selection.

The **New** selection has two items in a menu: **Basic Search** and **Advanced Search**. Each of these have submenus with more selections. Each selection will open a search page specific for that selection. See page 6 for information on the **Basic Search** function and page 8 for information on the **Advanced Search** function.

Clicking on a search name will run the search and display the results as a list.

Double clicking on a company name will open the *Company* page (see page 10) for that company. An item on the list is selected by clicking on the check box in the item’s row.

This page has a header with a menu bar with ten selections: **Action**, **View**, **Save**, **Search**, **Edit Data**, **Sort**, **Locate**, **Export**, **PDF**, and **Refresh**. These selections are similar to and operate in a similar manner as the selections in the *My Lists* page header. See page 128 for information about the *My Lists* page header selections.

The **Search** selection is not included in the *My Lists* page header. Clicking on this selection will open an *Advanced Search* page. See page 8 for information about the *Advanced Search* page.
Sample Search Criteria

This page has a list of sample searches. This page has a header with a menu bar with five selections: Action (with five items in a submenu), New, Export, PDF, and Refresh. These are similar to the selections in the My Lists page. See page 128 for information about these selections.

Clicking on a search title will open a list of search results. You may see the criteria used for the search by clicking on the Edit Data button in the tool bar of this window. This will open a Select Data Points window. You may then modify the criteria if desired and save the search as your own by renaming it and clicking on the Save button. See page 26 for information about the Select Data Points window.
Report Templates

The Report Templates selection has one item in it: My Report Templates.

My Report Templates

This page lists any report templates that may have been saved.

This page has a header with a menu bar with five selections: Action (with five items in a submenu), Export, PDF, and Refresh.

Action

The Action selection menu has five items: Edit, Share With, Rename, Save As, and Send To.

The Edit selection has one item in a submenu: Delete. Delete will remove any selected template.

Rename allows you to rename any selected template.

Save As will prompt you to save a selected template with new name. It will then be added to the My Report Templates page.

The Send To selection will send a selected list to a recipient either inside or outside your firm. The Within My Firm selection will open a Find Users Within My Company window. This window searches for users within the firm. Click on a user and then the OK button to send the list.

The Outside My Firm selection will open a Send Copy To window where you enter the recipient’s e-mail address.

The Share With selection is similar to Send To and has the same selections. The Share With selections allow you to share access to your items with another person.

Export

The Export selection in the tool bar will export the selected items to Excel. Only the information displayed on the list page will be exported.

PDF

The PDF selection in the tool bar will create a PDF report of the selected items. The report will be displayed in a new window in PDF format. Only the information displayed on the list page will be included in the report.

Refresh

The Refresh selection in the tool bar is used to refresh the data displayed on the templates page. If any data had been updated while you were looking at the page the new data will be displayed after the Refresh action is completed.
Template
Clicking on a template name will open a Report Settings window. Each Report Settings screen is tailored to the individual Reports selection. This window gives you the settings for that template.

To continue on to the report click on the OK button. This will open the report in a new report window. You may name and Save this report or E-mail it by using the Report Title data field and the buttons across the top of the window. Reports are saved to the Saved Reports selection under the Workspace topic in the Morningstar Direct menu column in the main Morningstar screen. You also have the option to print the report using the Adobe Reader controls in the display area.
Chart Templates

The Chart Templates selection will open the Chart Templates page. This page lists any chart templates that may have been saved.

This page has a header with a menu bar with five selections: Action (with five items in a submenu), New, Export, PDF, and Refresh.

Action

The Action selection menu has five items: Edit, Rename, Save As, Send To, and Share With.

The Edit selection has one item in a submenu: Delete. Delete will delete any selected template.

Rename allows you to rename any selected template.

Save As will prompt you to save a selected template with new name. It will then be added to the My Report Templates page.

The Send To selection will send a selected list to a recipient either inside or outside your firm. The Within My Firm selection will open will open a Find Users Within My Company window. This window searches for users within the firm. Click on a user and then the OK button to send the list.

The Outside My Firm selection will open a Send Copy To window where you enter the recipient’s e-mail address.

The Share With selection is similar to Send To and has the same selections. The Share With selections allow you to share access to your items with another person.

New

The New selection has a menu with eight items: Floating Bar, HB Style Map, HB Style Trail, Holdings Similarity, RB Style Trail, Scatterplot, Stacked Bar and Time Series. Each of these will open a process to produce a chart of the selected style.

Floating Bar, Scatterplot, and Time Series will open a Dialog window. See page 25 for information about the Dialog window.

HB Style Map, HB Style Trail, Holdings Similarity, and RB Style Trail will open a Select Investments window. See page 18 for information about the Select Investments window.

Stacked Bar will open a Find Investments window. See page 19 for information about the Find Investments window.
Export

The Export selection in the tool bar will export the selected items to Excel. Only the information displayed on the list page will be exported.

PDF

The PDF selection in the tool bar will create a PDF report of the selected items. The report will be displayed in a new window in PDF format. Only the information displayed on the list page will be included in the report.

Refresh

The Refresh selection in the tool bar is used to refresh the data displayed on the list page. If any data had been updated while you were looking at the page the new data will be displayed after the Refresh action is completed.

Chart List

Clicking on a chart name in the chart list will open the chart created for that template in a new window. See page 23 for information about the various charts.

Data Sets

The Data Sets selection has two items in it: My Data Sets and Sample Data Sets.

My Data Sets

This page lists any data sets that may have been saved.

This page has a header with a menu bar with five selections: Action (with five items in a submenu), New, Export, PDF, and Refresh.

Action

The Action selection menu has five items: Edit, Rename, Send To, Share With, and Assign Folder.

The Edit selection has one item in a submenu: Delete. Delete will delete any selected template.

Rename allows you to rename any selected template.

The Send To selection will send a selected list to a recipient either inside or outside your firm. The Within My Firm selection will open will open a Find Users Within My Company window. This window searches for users within the firm. Click on a user and then the OK button to send the list.
The **Outside My Firm** selection will open a *Send Copy To* window where you enter the recipient’s e-mail address.

The **Share With** selection is similar to **Send To** and has the same selections. The **Share With** selections allow you to share access to your items with another person.

Clicking on **Assign Folder** will open a window with a list of folders from which you may select to put the selected portfolio into. Highlight the folder in the list so that the folder name appears in the **Name** data field and click on the **OK** button.

**New**

The **New** menu selection will open a *Select Data Points* window. See page 26 for information about the *Select Data Points* window.

**Export**

The **Export** selection in the menu bar will export the *My Data Sets* page list to Excel. Only the list is exported.

**PDF**

The **PDF** selection will display the information in the *My Data Sets* page in PDF format. Only the list is displayed, not the data in the lists.

**Refresh**

Clicking on **Refresh** will update the data in the lists with the latest data available.

**Data Set List**

Clicking on a data set name will open that data set.

This page has a header with a menu bar with six selections: **Action**, **Save**, **Edit Data**, **Export**, **PDF**, and **Refresh**. These selections are similar to and operate in a similar manner as the selections in the *My Lists* page header. See page 128 for information about the *My Lists* page header selections.
Sample Data Sets

This page lists standard data set templates in Morningstar Direct.

This page has a header with a menu bar with five selections: Action (with five items in a submenu), New, Export, PDF, and Refresh. These are similar to the selections that are on the My Data Sets page. See page 140 for information about the menu bar.

Double-clicking on a sample data set title will open the data set. The data set elements will be displayed in a table. If you want to use this data set as a basis for your own data set, click on the Action menu selection and click on Save As in the menu that appears. The Action menu has three other selections: Add To, Delete, and Edit.

The Save As selection will open a Save As window that allows you to rename the data set. It will be added to the list of data sets in the My Data Sets page. Click on the OK button after entering a name.

The Add To selection will add any selected data points to the set you select. This selection will open a window with the list of data sets from the My Data Sets page. Select the one you want to add the data points to and click on the OK button.

The Delete selection will remove any selected data points from the list. This is not a permanent action, the deleted items will be replaced when you close the page. You may save the modified list by clicking on the Save As selection in the Action menu.
The Edit selection opens the Data Settings window. This window allows you to modify the settings of the selected data point. You may change the name of the data point and select new settings from the various drop-down menus. After you have finished making your changes click on the OK button.

This is not a permanent action, the changed items will be replaced when you close the page. You may save the modified list by clicking on the Save As selection in the Action menu.

Custom Database

The Custom Database selection has two items: Firm-Level Database and My Database.

Firm-Level Database

The Firm-Level Database selection opens the Firm-Level Database page.

There currently are no items on this list. When a sector has been customized and saved it will be listed on this page.

My Database

The My Database selection opens the My Database page.

This page has a header with nine selections: Action (with four items in a submenu), Add Investments, Column Management, Edit Data, Import, Locate, Save, Export, and Refresh.

Action

The Action menu has four items: Save As (with one item (Investment List) in a submenu), Add To (with one item (Investment List) in a submenu), Delete and Clear Content.

The Save As/Investment List selection will open a Save As window. This allows you to name the new Investment List. Clicking on OK will save it in the My Lists section of the Investment Lists selection of the Workspace topic. See page 128 for information about this My Lists section.

The Add To/Investment List selection will open an Add To window. Select the investment list you want from the list displayed and click on the OK button.
The **Delete** selection will remove any selected (check mark in the check box) item from the list.

The **Clear Content** selection will remove classifications from the items you select on the list.

**Add Investments**

The **Add Investments** selection will open the *Find Investments* window. You may use this window to add items to the selected investment list. See page 19 for information about the *Find Investments* window.

**Column Management**

The **Column Management** selection will open the *Column Management* window. You may use this window to add new columns to the table. The new columns are added after the standard columns.

The **Add** button in this window displays a list of more than a dozen types of columns you may add. After making a selection the new column will be added to the list in the *Column Management* window, with a box where you may name the column.

When finished, click on the **OK** button. The new column will be added to the My Database table.

**Edit Data**

The **Edit Data** selection will open a *Select Data Points* window. See page 26 for information about the *Select Data Points* window.

**Import**

The **Import** selection opens an *Import* window where you may set up a table of data to import into Morningstar.

**Locate**

The **Locate** selection will open a *Select an Investment* window where you may enter a term into the search box. The list will scroll as you type.
Save

Save will save the select item.

Export

Export will send the list to Excel. Only the list is sent, not the contents of the items on the list.

Refresh

Refresh will refresh the list so any recent changes will be displayed.

Saved Reports

The Saved Reports selection opens the Saved Reports page. This page lists all the reports that have been saved. When a report is saved anywhere in Morningstar Direct it is sent to this list.

This page has a menu bar with four items: Action (with two selections in a menu), Export, Print and Refresh.

The Action menu has Delete and Assign Folder. Delete will remove any selected items from the list. Assign Folder will open a window where you may select the location for the selected items. Currently there are no special folders.

Export will send the list to Excel. Only the list is sent, not the contents of the items on the list.

Print will send the list to the printer. Only the list is sent, not the contents of the items.

Refresh will refresh the list so any recent changes will be displayed.

Double clicking on an item on the list will open the report for that item in a new window. See page 11 for information about the Report window.

Note Manager

The Note Manager selection opens the Note Manager page. This page lists any notes that have been saved. When a note is saved anywhere in Morningstar Direct it is sent to this list.

The page is in two sections. The upper section has the list of notes.
The lower section has three tabs: Filter Settings, Note Settings, and Note Content. Each of these tabs has settings and other controls that allow you to adjust the way notes are displayed and the information available about each note.

The upper section has a menu bar with eight items: Action (with six selections in a menu), New Note, Export, Print, Edit View, Note Settings, a Filter menu and Modify Filter.

The Action menu has six items: New Note, Duplicate Note, Delete Note(s), Import, New Filter and Share Outside My Firm.

**New Note** will open a Morningstar Direct window where you may set up the criteria for a new note, enter the text and attach it to the desired item (i.e., security).

**Duplicate Note** will open the Morningstar Direct window with the information of the selected note filled in. Clicking on the Save button will create a new note with the same name and parameters as the one selected.

**Delete Note(s)** will remove any selected notes from the list.

The **Import** selection opens an Import window where you may set up a table of data to import into Morningstar.

New Filter does not perform any function at this time.

**Share Outside My Firm** will open a window where you may enter the e-mail address of the person with whom you wish to share the note.

**New Note** will open the same Morningstar Direct window as the **New Note** selection in the Action menu.

The **Export** selection will send the list to Excel. Only the list will be sent, not the contents of the items on the list.

**Print** will print the list. Only the list will be printed, not the contents of the items on the list.

The **Edit View** selection has a drop-down menu with selections for the various columns available. Columns with a check mark in the box next to it will be displayed. To add or remove columns for the table check or uncheck the box and the display will be refreshed.

**Note Settings** will open the Note Default Settings window. This window has selections in three sections (Note Display Settings, New Note Settings, and Note Relationship Settings for Investments). Each selection has a menu from which you may select the setting you wish to use. Click on the OK button when you are finished.
The Filter menu has selections for the various filters that may be used.

Modify Filter will open a window where you may make selections to change a filter (name, etc.).

Retirement Plans

The Retirement Plans selection opens the Retirement Plans page.

This page lists any retirement plans that have been saved. When a plan is saved anywhere in Morningstar Direct it is sent to this list.

There is a menu bar with five selections: Action, Import, New, Fee Settings, and Export.

Action has a menu with five items: Delete, Rename, Save As, Send To, and Share With.

Delete will remove the selected plan.

Rename allows you to rename any selected plan.

Save As will prompt you to save a selected plan with new name.

The Send To selection will send a selected list to a recipient either inside or outside your firm. The Within My Firm selection will open will open a Find Users Within My Company window. This window searches for users within the firm. Click on a user and then the OK button to send the list.

The Outside My Firm selection will open a Send Copy To window where you enter the recipient’s e-mail address.

The Share With selection is similar to Send To and has the same selections. The Share With selections allow you to share access to your items with another person.

The Import selection opens an Import window where you may set up a table of data to import into Morningstar.

New will open the Select Investments window. See page 18 for information about the Select Investments window.

Fee Settings will open the Fee settings window. This window is used to set up the fees associated with retirement plans.

Export will send the list to Excel. Only the list is sent, not the contents of the items on the list.
Clicking on a retirement plan in the list will open the *Retirement Plan* page. This page lists the various vehicles used to populate the selected plan. These include Equities, Funds and Money Markets.

**Group Manager**

The *Group Manager* selection has two items under it: *Groups* and *Requests*.

The *Groups* selection opens the *Groups* page, which is used to manage the groups created within Morningstar. Currently there are no saved groups.

The *Requests* selection opens the *Requests* page. There are currently no requests listed.
# Window Index

<table>
<thead>
<tr>
<th>Window</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Search</td>
<td>8</td>
</tr>
<tr>
<td>Account Basics Window</td>
<td>29</td>
</tr>
<tr>
<td>Basic Search</td>
<td>6</td>
</tr>
<tr>
<td>Chart</td>
<td>23</td>
</tr>
<tr>
<td>Chart Settings</td>
<td>26</td>
</tr>
<tr>
<td>Company Page</td>
<td>10</td>
</tr>
<tr>
<td>Definition Master Window</td>
<td>42</td>
</tr>
<tr>
<td>Dialog</td>
<td>25</td>
</tr>
<tr>
<td>Filings Page</td>
<td>51</td>
</tr>
<tr>
<td>Find Investments</td>
<td>19</td>
</tr>
<tr>
<td>Group Settings Window</td>
<td>32 &amp; 69</td>
</tr>
<tr>
<td>Import Window</td>
<td>45 &amp; 91</td>
</tr>
<tr>
<td>Investments: Settings Window</td>
<td>108</td>
</tr>
<tr>
<td>Model Portfolio Basics Window</td>
<td>32</td>
</tr>
<tr>
<td>Morningstar Presentation Studio Window</td>
<td>118</td>
</tr>
<tr>
<td>New Account window</td>
<td>29</td>
</tr>
<tr>
<td>New Folder Window</td>
<td>17</td>
</tr>
<tr>
<td>New Report Window</td>
<td>33</td>
</tr>
<tr>
<td>Numeric Rule-Based Window</td>
<td>67</td>
</tr>
<tr>
<td>Object Attribute Assignments Window</td>
<td>40</td>
</tr>
<tr>
<td>Performance Attribution Window</td>
<td>35</td>
</tr>
<tr>
<td>Price Monitor Window</td>
<td>48</td>
</tr>
<tr>
<td>Report and Report Select Pages Windows</td>
<td>11</td>
</tr>
<tr>
<td>Report Page</td>
<td>78</td>
</tr>
<tr>
<td>Report Settings</td>
<td>21</td>
</tr>
<tr>
<td>Report Window</td>
<td>11</td>
</tr>
<tr>
<td>Select a Security</td>
<td>62</td>
</tr>
<tr>
<td>Select Data Points Window</td>
<td>26</td>
</tr>
<tr>
<td>Select Investments</td>
<td>18</td>
</tr>
<tr>
<td>Select Multiple Portfolios Window</td>
<td>68</td>
</tr>
<tr>
<td>Settings Window</td>
<td>36</td>
</tr>
<tr>
<td>Universe Page</td>
<td>58</td>
</tr>
<tr>
<td>X-Ray Window</td>
<td>60</td>
</tr>
</tbody>
</table>